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INTRODUCTION

This document describes how to install the printer drivers and printer description files for the 
EX700i Print Server/Integrated Fiery Color Server. This document covers the following 
topics:

• Installing printer files on Apple Mac OS computers 

• Setting up the Mac OS X computer for printing

• Printing from Mac OS computers 

• Installing printer files on Microsoft Windows computers 

• Setting up the printing connections on Windows computers 

• Printing from Windows computers 

• EX700i Print Server/Integrated Fiery Color Server print options 

• Using printing methods other than the printer driver to print to the EX700i Print Server/
Integrated Fiery Color Server 

For information about setting up network servers and clients to use the EX700i Print Server/
Integrated Fiery Color Server, see Configuration and Setup. For general information about 
using the color digital press, your computer, application software, or network, see the 
documentation that accompanies those products.

For information about supported operating systems and system requirements, see Welcome.
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Terminology and conventions
This document uses the following terminology and conventions.

Term or convention Refers to

Aero EX700i (in illustrations and examples)

Digital press Xerox 700 Digital Color Press

EX700i EX700i Print Server/Integrated Fiery Color Server

Titles in italics Other documents in this set

Windows Microsoft Windows XP, Windows Vista, Windows Server 2003/
2008/2008 R2, Windows 7

Topics for which additional information is available by starting 
Help in the software

Tips and information

A warning concerning operations that may lead to death or injury 
to persons if not performed correctly. To use the equipment safely, 
always pay attention to these warnings.

A caution concerning operations that may lead to injury to persons 
if not performed correctly. To use the equipment safely, always pay 
attention to these cautions.

Operational requirements and restrictions. Be sure to read these 
items carefully to operate the equipment correctly, and avoid 
damage to the equipment or property.
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User software for printing
The following table lists the user software that is described in this document. This is the user 
software you need for setting up basic printing on the EX700i. Other documents may 
describe user software that can be used to print documents. 

User software Description

PostScript Printer Description 
(PPD) file and associated files
(for Windows)

Provide information about the EX700i and your particular digital 
press model to your application and printer driver.

PostScript Printer Description 
(PPD/Plugin) files
(for Mac OS X)

Used with the PostScript printer driver to allow the EX700i to 
appear in the Print and Page Setup dialog boxes of popular 
applications. The EX700i PPDs provide information about the 
digital press to your application and printer driver.

PageMaker PPD files Allow you to print to the EX700i from Adobe PageMaker. You must 
install the appropriate PPD in PageMaker. For instructions, see the 
documentation that accompanies PageMaker.

PostScript screen fonts
(for Mac OS X)

PostScript/TrueType screen fonts that correspond to the printer fonts 
installed on the EX700i. For a complete list of PostScript/TrueType 
fonts installed on the EX700i, print a Font List.

For more information, see Command WorkStation Help. 

Job Monitor 
(for Windows)

Monitor the status of each connected EX700i and the print jobs sent 
to it. Job Monitor is automatically installed when the printer driver 
is installed on a Windows computer.

For more information, see “Configuring and using Job Monitor” on 
page 86.

Printer Delete Utility 
(for Windows)

Uninstall the Windows printer driver. 

For more information, see “Uninstalling printer drivers” on page 45 
and page “Uninstalling printer drivers” on page 70.

Fiery Software Uninstaller 
Utility 
(for Mac OS X)

Uninstall the Mac OS X printer and associated printer driver files.

For more information, see “Uninstalling printer driver files” on 
page 13.
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MAC OS X

To set up the EX700i as a PostScript printer on a Mac OS X computer, install the printer 
driver files that correspond to your digital press and set up the EX700i for printing. Printer 
drivers provide a way to communicate information about print jobs between your 
applications, the EX700i, and the digital press.

For the location of each procedure, see the following table.

Installing the Mac OS X printer driver files
Installing printer drivers files is the first step in setting up the EX700i as a printer. 

NOTE: If the EX700i printer driver is already installed, you must uninstall it before you install 
a new driver (see “Uninstalling printer driver files” on page 13).

The following sections describe how to install the printer files for the EX700i.

Procedure See

Installing the Mac OS X printer driver files page 10

Setting up the Mac OS X computer for printing page 14

Printing from Mac OS X computers page 28

Procedure See

Installing printer drivers from the User Software DVD page 11

Downloading printer drivers using WebTools page 12

Downloading printer drivers from the EX700i page 12

Uninstalling printer driver files page 13
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Installing from the User Software DVD

The User Software DVD provides the following software for Mac OS X (see the 
OSX : Printer Driver folder):

• OSX Installer: Installs the printer driver files required to print from Mac OS X.

• Language folders: Printer description files that are installed by OSX Installer. You do not 
need to open these folders or install them manually on your computer. The appropriate 
files are installed by OSX Installer.

TO INSTALL THE PRINTER DRIVER FILES FOR MAC OS X

1 Quit all open applications.

2 Mac OS X v10.3.9 and v10.4.x: Make sure that the Printer Setup Utility is not running on your 
computer.

Printer Setup Utility updates the list of available printers when it starts. If a printer 
description file is added while Printer Setup Utility is running, you cannot select the 
associated printer model until you restart.

Mac OS X v10.5.x and v10.6.x: Proceed to step 3.

3 Insert the User Software DVD into the DVD drive.

4 Open the OSX : Printer Driver folder on the User Software DVD.

If you are installing from a folder you downloaded from WebTools or the EX700i, browse to 
the Printer Driver folder on your desktop.

5 Double-click the OSX Installer icon to start installing the printer driver.

6 Follow the on-screen instructions.

The OSX Installer installs the printer driver files that correspond to the EX700i.

7 When copying is complete, click Quit.
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Downloading printer drivers using WebTools

If your administrator has enabled access to WebTools, you can download installers for printer 
drivers to your computer directly from the EX700i. 

For more information about setting up and starting WebTools, see Utilities.

TO DOWNLOAD PRINTER DRIVERS WITH WEBTOOLS

1 Start your Internet or intranet browser and type the DNS name or IP address of the EX700i.

2 Click the Downloads tab. 

3 Click the link for the printer drivers that you want to install (Printer Files for Mac OS X).

A file named OSX.dmg is downloaded to your desktop. The file contains a folder named 
Printer Driver in a compressed format. If your Internet browser is equipped with an expander 
utility, such as StuffIt Expander, the folder decodes and decompresses automatically.

If the Printer Driver folder does not automatically decode and decompress, double-click the 
file to start the utility that performs that function.

4 Open the OSX : Printer Driver folder.

5 Double-click the OSX Installer icon to start installing the printer driver.

Follow the on-screen instructions.

6 When copying is complete, click Quit.

Downloading printer drivers from the EX700i

You can download printer driver files to your computer directly from the EX700i over the 
network.

TO DOWNLOAD PRINTER DRIVER FILES FROM THE EX700I

1 In the Finder, choose Connect to Server from the Go menu.

2 Type SMB:// followed by the name or IP address of the EX700i and click Connect.

If you cannot locate your EX700i, contact your administrator.

3 Type the user name and password in the SMB/CIFS File System Authentication dialog box.

The “Guest” account can be used as the default. The Guest account does not require a 
password. If the Guest account cannot be used, ask your network administrator for an 
account.

4 Select the Mac_User_SW folder from the shared volume list and click OK.

5 Open the OSX : Printer Driver folder.

6 Double-click the OSX Installer icon to start installing the printer driver.

Follow the on-screen instructions.
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Uninstalling printer driver files

The Fiery Software Uninstaller utility is installed and used locally. You do not need to connect 
to the EX700i before you use the software.

TO INSTALL AND USE THE FIERY SOFTWARE UNINSTALLER UTILITY

1 Copy Fiery Software Uninstaller.dmg to the desktop from the User Software DVD or the 
Mac_User_SW folder from the shared volume list on the EX700i.

2 On the desktop, double-click Fiery Software Uninstaller.dmg.

The Fiery Software Uninstaller opens in the Finder, showing the Fiery Software Uninstaller 
icon and an arrow pointing to a link to the Applications folder.

3 Select the Fiery Software Uninstaller icon on the left and drag it onto the Applications folder.

4 Browse to the Applications folder and double-click the Fiery Software Uninstaller icon.

5 Click the Printers tab if it is not already selected.

6 Select a printer from the Installed Printers list and do one of the following:

• Click Remove Printer and Driver to remove the printer along with its printer driver files.

If you want to remove the printer and the associated printer driver, you can select only one 
printer at a time.

• Click Remove Printer to remove the printer from the Installed Printers list only, but leave 
the printer driver installed.

The utility can remove only printers that are not currently in use or open on the Dock.

NOTE: If more than one printer uses a printer driver, removing the printer driver also removes 
all printers using that driver.

7 To confirm that you want to delete the printer, type the password for your Mac OS X computer 
in the dialog box and click OK.

8 Click the Drivers tab to view the installed printer drivers.

9 Close the Fiery Software Uninstaller dialog box.

TO DELETE THE FIERY SOFTWARE UNINSTALLER UTILITY

• Delete the Fiery Software Uninstaller icon from the Mac OS X Applications folder.
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Setting up the Mac OS X computer for printing
The following section describes how to set up the EX700i on a Mac OS X computer.

Setting up printing with Mac OS X v10.6.x

Use the following procedures to set up the EX700i on a computer with Mac OS X v10.6.x.

TO SET UP THE EX700I FROM THE PRINT DIALOG BOX

1 Open a file in your application.

2 Choose Print from the File menu.

The Print dialog box appears.

3 Select Add Printer from the Printer list.

In the dialog box that appears, select a printer connection. Use one of the printer connections 
in the following table to add a printer.

TO SET UP THE EX700I USING PRINT & FAX

1 Choose System Preferences from the Apple menu, and then choose Print & Fax.

The Print & Fax dialog box appears.

2 Click the “+” button to add a printer.

In the dialog box that appears, select a printer connection. Use one of the following 
connections to add a printer.

Procedure See

Setting up printing with Mac OS X v10.6.x page 14

Setting up printing with Mac OS X v10.5.x page 17

Setting up printing with Mac OS X v10.4.x page 21

Setting up printing with Mac OS X v10.3.9 page 25

Adding a non-English printer on Mac OS X v10.5.x and v10.6 page 27

Configuring installable options page 27

Using Desktop Printer (optional) page 27

Printing connection See

Default (Bonjour) page 15

IP Printer page 16
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TO ADD A PRINTER WITH THE DEFAULT (BONJOUR) CONNECTION

NOTE: Bonjour printer setup works only if the EX700i is on the same LAN as the client 
Mac OS X computer. Bonjour must also be enabled on the EX700i.

1 Click the Default icon in the dialog box.

The names of printers with default connections are listed. The virtual printers that are 
configured at the EX700i are also listed.

NOTE: The names of the virtual printers appear as printer name:virtual printer name in the 
Printer Name list.

2 Select the EX700i from the list.

The information about the selected printer appears at the bottom of the Default pane. 
The appropriate PPD file for the EX700i is automatically selected. If your administrator 
configured the Secure Access printing at the EX700i, the PPD file for Secure Access printing 
is selected.

3 Click Add.

The Installable Options pane in the Print & Fax dialog box appears. 

4 Click Continue. 

The EX700i name appears in the Printer List.

5 Choose EX700i from the Printer List.

6 Click Options & Supplies, and then click the Driver tab.

7 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.
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TO ADD A PRINTER WITH THE IP PRINTER CONNECTION

1 Click the IP icon in the dialog box.

2 LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the EX700i IP 
address or DNS name in the Address field, and then type the print connection (print, hold or 
direct) in the Queue field. Proceed to step 4.

IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the EX700i 
IP address or DNS name in the Address field. Proceed to step 3.

The IP address or DNS name appears in the Name field.

3 Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) 
in lowercase letters in the Queue field.

NOTE: The EX700i requires a queue name. Do not leave the Queue field empty.

4 Choose Select Printer Software from the Print Using menu. 

5 Locate the digital press manufacturer or model in the list, select the PPD file, and then click 
OK. 

6 Click Add.

The Installable Options pane in the Print & Fax dialog box appears. 

7 Click Continue. 

The EX700i with its IP address appears in the Printer List.

8 Choose EX700i from the Printer List.

9 Click Options & Supplies, and then click the Driver tab.

10 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.
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Setting up printing with Mac OS X v10.5.x

Use the following procedures to set up the EX700i on a computer with Mac OS X v10.5.x.

TO SET UP THE EX700I FROM THE PRINT DIALOG BOX

1 Open a file in your application.

2 Choose Print from the File menu.

The Print dialog box appears.

3 Select Add Printer from the Printer list.

In the dialog box that appears, select a printer connection. Use one of the printer connections 
in the following table to add a printer.

TO SET UP THE EX700I USING PRINT & FAX

1 Choose System Preferences from the Apple menu, and then choose Print & Fax.

The Print & Fax dialog box appears.

2 Click the “+” button to add a printer.

In the dialog box that appears, select a printer connection. Use one of the following 
connections to add a printer.

Printing connection See

Default (Bonjour or AppleTalk) page 18

IP Printer page 19

AppleTalk page 20
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TO ADD A PRINTER WITH THE DEFAULT (BONJOUR OR APPLETALK) CONNECTION

NOTE: Bonjour printer setup works only if the EX700i is on the same LAN as the client 
Mac OS X computer. Bonjour must also be enabled on the EX700i.

1 Click the Default icon in the dialog box.

The names of printers with default connections are listed. The virtual printers that are 
configured at the EX700i are also listed.

NOTE: The names of the virtual printers appear as printer name: virtual printer name in the 
Printer Name list.

2 Select the EX700i from the list.

The information about the selected printer appears at the bottom of the Default pane. The 
appropriate PPD file for the EX700i is automatically selected. 

3 Click Add.

AppleTalk: The EX700i name appears in the Printer List of the Print & Fax dialog box.

Bonjour: The Installable Options pane in the Print & Fax dialog box appears. Click Continue 
to return to the Print & Fax dialog box. The EX700i name appears in the Printer List.

4 Choose the EX700i from the Printer List.

5 Click Options & Supplies, and then click the Driver tab.

6 Specify the installable option settings, and then click OK.
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TO ADD A PRINTER WITH THE IP PRINTER CONNECTION

1 Click the IP icon in the dialog box.

2 LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the EX700i IP 
address or DNS name in the Address field, and then type the print connection (print, hold, or 
direct) in the Queue field. Proceed to step 4.

IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the EX700i 
IP address or DNS name in the Address field. Proceed to step 3.

The IP address or DNS name appears in the Name field.

3 Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) 
in lowercase letters in the Queue field.

NOTE: The EX700i requires a queue name. Do not leave the Queue field empty.

4 Choose Select a driver to use from the Print Using menu. 

5 Locate the digital press manufacturer or model in the list, select the PPD file, and then click 
OK. 

6 Click Add.

The Installable Options pane in the Print & Fax dialog box appears. 

7 Click Continue. 

The EX700i with its IP address appears in the Printer List.

8 Choose the EX700i from the Printer List.

9 Click Options & Supplies, and then click the Driver tab.

10 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.
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TO ADD A PRINTER WITH THE APPLETALK CONNECTION

NOTE: Use this procedure if the EX700i is in a different AppleTalk zone than your computer. 
If the EX700i is in the same zone, it is displayed as a default following the procedure on 
page 18.

1 Click the AppleTalk icon in the dialog box.

2 Select the AppleTalk zone for the EX700i from the list.

The AppleTalk printers in the specified zone are listed. The virtual printers that are 
configured at the EX700i are also listed.

NOTE: The names of the virtual printers appear as printer name: virtual printer name in the 
Name list.

3 Select the EX700i name in the Printer List and click Add.

The EX700i name appears in the Printer List of the Print & Fax dialog box.

4 Choose the EX700i from the Printer List.

5 Click Options & Supplies, and then click the Driver tab.

6 Specify the installable option settings, and then click OK.
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Setting up printing with Mac OS X v10.4.x

Use the following procedures to set up the EX700i on a computer with Mac OS X v10.4.x.

TO SET UP THE EX700I FROM THE PRINT DIALOG BOX

1 Open a file in your application.

2 Choose Print from the File menu.

The Print dialog box appears.

3 Select Add Printer from the Printer list.

In the dialog box that appears, select a printer connection. Use one of the printer connections 
in the following table to add a printer.

TO SET UP THE EX700I USING PRINTER SETUP UTILITY

1 In the Finder, choose Utilities from the Go menu.

2 Start Printer Setup Utility.

The Printer List dialog box appears.

3 Click Add.

In the dialog box that appears, select a printer connection. Use one of the printer connections 
in the following table to add a printer.

TO SET UP THE EX700I USING PRINT & FAX

1 Choose System Preferences from the Apple menu, and then choose Print & Fax.

The Print & Fax dialog box appears.

2 Click the “+” button to add a printer.

In the dialog box that appears, select a printer connection. Use one of the following 
connections to add a printer.

Printing connection See

Default Browser (Bonjour or AppleTalk) page 22

IP Printer page 23

AppleTalk page 24
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TO ADD A PRINTER WITH THE DEFAULT BROWSER (BONJOUR OR APPLETALK) CONNECTION

NOTE: Bonjour printer setup works only if the EX700i is on the same LAN as the client 
Mac OS X computer. Bonjour must also be enabled on the EX700i.

1 Click Default Browser in the Printer Browser dialog box.

The names of printers with default connections are listed. The virtual printers that are 
configured at the EX700i are also listed.

If the printer is not listed in the Printer Name list, click More Printers.

NOTE: The names of the virtual printers appear as printer name: virtual printer name in the 
Name list.

2 Select the EX700i from the list.

The information about the selected printer appears at the bottom of the Default Browser 
pane. The appropriate PPD file for the EX700i is automatically selected.

3 Click Add.

AppleTalk: The EX700i name appears in the Printer List of the Print & Fax dialog box.

Bonjour: The Installable Options pane in the Printer Browser dialog box appears. Click 
Continue to return to the Print & Fax dialog box. The EX700i name appears in the Printer 
List.

4 Choose the EX700i from the Printer List and click Show Info. 

5 In the Printer Info dialog box, choose Installable Options, specify the installable option 
settings, and then click Apply Changes. 

6 Close the Printer Info dialog box.
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TO ADD A PRINTER WITH THE IP PRINTER CONNECTION

1 Click IP Printer in the Printer Browser dialog box.

2 LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the EX700i IP 
address or DNS name in the Address field, and then type the print connection (print, hold, or 
direct) in the Queue field. Proceed to step 6.

IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the EX700i 
IP address or DNS name in the Address field. Proceed to step 3.

The IP address or DNS name appears in the Name field.

3 Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) 
in lowercase letters in the Queue field.

NOTE: The EX700i requires a queue name. Do not leave the Queue field empty.

4 Print Using: Locate the digital press manufacturer or model in the list, and then select the 
PPD file. 

5 Click Add.

The Installable Options pane in the Printer Browser dialog box appears. 

6 Click Continue. 

The EX700i with its IP address appears in the Printer List.

7 Choose EX700i from the Printer List and click Show Info.

8 In the Printer Info dialog box, choose Installable Options, specify the installable option 
settings, and then click Apply Changes. 

For information about configuring installable options, see printer driver Help.

9 Close the Printer Info dialog box.



MAC OS X 24

TO ADD A PRINTER USING THE APPLETALK CONNECTION

NOTE: Use this procedure if the EX700i is in a different AppleTalk zone than your computer. 
If the EX700i is in the same zone, it is displayed as a default following the procedure on 
page 22.

1 Click Default Browser or IP Printer in the Printer Browser dialog box.

2 Click More Printers.

The dialog box with a list of other connections appears.

3 Select AppleTalk from the connection list.

The AppleTalk pane appears.

4 Select the AppleTalk zone for the EX700i from the list.

The AppleTalk printers in the specified zone are listed. The virtual printers that are 
configured at the EX700i are also listed.

NOTE: The names of the virtual printers appear as printer name: virtual printer name in the 
Name list.

5 Select the EX700i name in the Name list and click Add.

The EX700i name appears in the Printer List dialog box.

6 Choose EX700i from the Printer List and click Show Info. 

7 In the Printer Info dialog box, choose Installable Options, specify the installable option 
settings, and then click Apply Changes. 

8 Close the Printer Info dialog box.
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Setting up printing with Mac OS X v10.3.9

Use the following steps for setting up the EX700i on a computer with Mac OS X v10.3.9.

TO SET UP THE EX700I FOR PRINTING

1 In the Finder, choose Utilities from the Go menu.

2 Start Printer Setup Utility or Print Center.

The Printer List dialog box appears.

3 Click Add.

In the dialog box that appears, select a printer connection. Use one of the following 
connections to add a printer.

TO ADD A PRINTER WITH THE APPLETALK CONNECTION

1 Select AppleTalk from the list.

2 Select the AppleTalk zone for the EX700i from the zone pop-up list.

The AppleTalk printers in the specified zone are listed. The virtual printers that are 
configured at the EX700i are also listed.

NOTE: The names of the virtual printers appear as printer name: virtual printer name in the 
Name list.

3 Select the EX700i name in the Name list. 

4 Click Add.

The appropriate PPD file for the EX700i is automatically selected.

The EX700i name appears in the Printer List.

Printing connection See

AppleTalk page 25

LPD/LPR page 26
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TO ADD A PRINTER WITH THE LPD/LPR CONNECTION

1 Select IP Printing from the list.

2 Select LPD/LPR from the Printer Type list.

3 Type the EX700i IP address in the Printer Address field.

4 Type the virtual printer name in the Queue Name field or leave it blank for the default queue.

5 Select the appropriate model from the Printer Model list.

6 Select the PPD file from the Model Name list.

7 Click Add.

The EX700i with its IP address appears in the Printer List.
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Adding a non-English printer on Mac OS X v10.5 and v10.6

When adding a non-English EX700i printer on Mac OS X v10.5 and 10.6, you must 
navigate to Other to select the correct printer driver for your language.

TO ADD A NON-ENGLISH PRINTER

1 Open the Add Printer dialog box.

The list of available Bonjour printers is displayed.

2 Select the EX700i from the list.

3 From the Print Using menu, select Other.

4 On your computer, navigate to Library > Printers > PPDs > Contents > Resources, and open the 
language folder that corresponds to the language you are using on your system.

5 Select the EX700i from the list.

6 Click Open, then click Add.

Configuring installable options
To use the print options for the digital press and EX700i appropriately, you must configure 
the EX700i from your computer for the options that are installed on the digital press. 
Configure the options manually. 

For information about configuring installable options, see printer driver Help.

Using Desktop Printer (optional)

After adding the EX700i to the Printer List in Print & Fax or the Printer Setup Utility, you 
can create and use the Desktop Printer feature.

For information about the Desktop Printer feature, see printer driver Help.
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Printing from Mac OS X computers
You can print to the EX700i just as you would print to any other printer from a 
Mac OS X application. Select the EX700i as the current printer in the Printer List, specify 
print options, and then print the document from the application. 

The following table includes other methods to print to the EX700i and describes where to 
find information about these features.

For more information See

Downloading files to the EX700i using the Docs WebTool  Utilities

Printing documents using Hot Folders  Utilities

Printing documents using Command WorkStation  Utilities

Achieving optimal printing results from applications Color Printing and Fiery 
Color Reference

Selecting the EX700i in the Printer List page 29

Setting print options and printing from Mac OS X applications page 30

Customizing the Quick Access view page 33

Viewing the digital press status page 33

Defining and printing custom page sizes page 129
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Selecting the EX700i in the printer list

Before you print a job, you must select the EX700i from the printer list. Use the following 
procedure to select the EX700i as your default printer.

TO SELECT THE EX700I AS THE DEFAULT PRINTER WITH MAC OS X V10.5 OR V10.6

1 Make sure that the EX700i is connected to the network and turned on.

2 Choose System Preferences from the Apple menu, and then choose Print & Fax.

The printers that are set up for printing are listed. The virtual printers that are configured at 
the EX700i and set up for printing are also listed.

3 To make the EX700i the default printer, select it from the Default Printer menu.

4 Close the window.
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TO SELECT THE EX700I AS THE DEFAULT PRINTER WITH MAC OS X V10.4.X OR V10.3.9

1 Make sure that the EX700i is connected to the network and turned on.

2 In the Finder, choose Utilities from the Go menu.

3 Start Printer Setup Utility.

The printers that are set up for printing are listed. The virtual printers that are configured at 
the EX700i and set up for printing are also listed.

4 To specify it as your current printer, select the EX700i in the Printer List.

5 Click the Make Default icon.

The EX700i is now your default printer.

Setting print options and printing from Mac OS X applications

To print from Mac OS X client computers, install the printer driver files. For instructions, see 
“Installing the Mac OS X printer driver files” on page 10. In Mac OS X applications, print 
options are set from the Print dialog box. 

Some print options that are selectable from an application are similar to print options that are 
specific to the EX700i and the digital press. In these cases, use the print options specific to the 
EX700i and the digital press. These options appear in the Fiery Features pane and/or in the 
Printing Preferences window. The application may not set up the file properly for printing on 
the EX700i, resulting in unexpected finishing, printing errors, or longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box 
provides instructions to resolve the conflict.

Some print options, such as expert color settings, are available only if Two-Way 
Communication is enabled or if a particular installable option has been configured. For 
information about enabling Two-Way Communication, see printer driver Help. For 
information about configuring installable options, see “Configuring installable options” on 
page 27.

If you choose Printer’s default, the job prints according to the settings that the administrator 
specified in Setup. For more information, see page 99.
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The following procedure explains how to use the printer driver to specify print options for a 
particular job and print it to the EX700i. For information about print options, see page 98.

NOTE: The following procedure uses Mac OS X v10.5 illustrations.

TO SET PRINT OPTIONS AND PRINT FROM MAC OS X

1 In your application, choose File > Print, and select the EX700i as your printer.

2 Choose Fiery Features from the drop-down list.

For information about using presets, see printer driver Help.

NOTE: For a list of print options, see page 100.

1 Fiery Features
2 Customize button
3 Full Properties button
4 Presets menu
5 Two-Way Communication 1

2

3

4

5
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3 Click Full Properties in the Quick Access pane to specify print options and settings for your 
job.

The print options are grouped by categories. Each group or tab contains print options that are 
similar or complement one another.

The groups or tabs are as follows:

Quick Access contains duplicate print options from the other job properties groups. It is 
customizable, so any Job Override print option can be added or removed from the view. The 
Quick Access tab lets you find print options quickly without having to browse through all the 
Properties tabs. For information about customizing the Quick Access view, see page 33.

Job Info contains all information about the job, including user information that may be 
required for user authentication, secure print properties, job handling, and document server. 
For information about Job Info options, see page 101.

Media contains attributes and sources of paper to print and insert. For information about 
Media options, see page 103.

Layout defines how the file is positioned or imaged on the media/sheet, except for positioning 
that compensates for finishing options, for example, Tray Alignment. For information about 
Layout options, see page 106.

Color contains color settings and graphic arts features (when enabled). For information about 
Color options, see page 111.

Image contains all Image Quality settings supported by the connected EX700iand digital 
press. For information about Image options, see page 116.

Finishing contains print options that are specific to the EX700i and to the finishing 
equipment on the digital press. These options override settings in EX700i Printer Setup but 
can be changed from Command WorkStation. For information about Finishing options, see 
page 117. 

VDP contains all Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP 
settings. For information about VDP options, see page 119.

Stamping contains any image stamping option that adds or hides/removes any image on the 
job. This also includes watermark properties that define the placement and style of the 
watermark. For information about Stamping/Watermark options, see page 120 or printer 
driver Help.

Printer contains digital press status that includes the current paper and dry ink levels. For 
more information, see page 33 or printer driver Help.

4 After you specify the print settings, click Print to send your print job.
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Customizing the Quick Access view

The Quick Access view can be customized with the print options that you use frequently. This 
saves time because you do not have to open all of the other print option icons if you only want 
to set the options in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option 
icon. You can set the option from either location.

TO CUSTOMIZE QUICK ACCESS

1 In your application, choose File > Print, and select the EX700i as your printer.

2 Choose Fiery Features from the drop-down list.

3 Click Customize to specify the options shown in the Quick Access window.

You can select a shortcut from the Available Shortcuts list and add it to the Current Shortcuts 
list, as well as remove a shortcut from the Current Shortcuts list. Click OK to save your 
changes.

For information about Quick Access view, see printer driver Help.

Viewing the digital press status

If you enable a TCP/IP network, you can retrieve the digital press status and color settings 
from the EX700i and display them in the printer driver with the Two-Way Communication 
option. The digital press status includes the current paper and dry ink levels. You can set the 
color settings on the EX700i with Command WorkStation. For more information about 
color print options, see Color Printing or Command WorkStation Help.

For information about monitoring digital press status, see printer driver Help.
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WINDOWS FOR EX700I PRINT SERVER

To set up the EX700i as a digital press on a Windows computer, install the printer driver files 
that correspond to your digital press and set up the EX700i for printing. Printer drivers 
provide a way to communicate information about print jobs between your applications, the 
EX700i, and the digital press.

For the location of each procedure, see the following table.

Installing Windows printer drivers
Installing printer drivers and printer description files is the first step in setting up the EX700i 
as a PostScript printer.

NOTE: Windows Vista, Windows 7, and Windows Server 2008 R2 have a User Account 
Control (UAC) feature. You must be the administrator or a user with administrator privileges 
to install printer drivers.

NOTE: If the EX700i printer driver is already installed, you must uninstall it before you install 
a new driver (see “Uninstalling printer drivers” on page 45).

The following sections describe how to install the printer files for the EX700i.

Procedure See

Installing Windows printer drivers page 34

Setting up the Windows computer for printing page 46

Printing from Windows computers page 54

Procedure See

Installing printer drivers by Point and Print page 35

Downloading printer drivers using WebTools page 37

Downloading printer drivers from the EX700i page 38

Installing printer drivers from the User Software DVD page 39

Installing and connecting to a virtual printer page 43

Uninstalling printer drivers page 45
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Installing printer drivers by Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript 
printer drivers on your computer from the EX700i using Point and Print, and print to a 
particular connection (Print queue, Hold queue, Direct connection, or Virtual Printer).

Each connection (print, hold, direct or virtual printer) requires a separate installation. Repeat 
the procedure for each connection.

When you install the printer driver using Point and Print, you cannot configure installable 
options manually. The installed options are displayed as the EX700i configuration in the 
printer driver. For more information, see “Configuring installable options” on page 53.

BEFORE YOU BEGIN

Ask your administrator to do the following in Setup on the EX700i:

• Assign the EX700i a valid IP address.

Ask your administrator for the IP address or DNS name required in the following procedure.

• Configure the EX700i for SMB printing.

NOTE: SMB printing is referred to as Windows Printing in Setup and on the Configuration 
page. 

For more information, see Configuration and Setup or Configure Help.

TO SET UP SMB PRINTING ON WINDOWS COMPUTERS

1 Windows 2000/XP/Server 2003: Right-click Network Neighborhood or My Network Places, and 
then select Find Computer or Search for Computers.
Windows Vista/Server 2008: Click Start, choose Control Panel, double-click Network and 
Sharing Center, and then click the View computers and devices link.
Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, 
choose Network and Sharing Center, and then click the View network computers and devices 
link.

2 Windows 2000/XP/Server 2003: Type the name or IP address of the EX700i and click Search 
Now or Search.
Windows Vista/Windows 7/Server 2008/Server 2008 R2: Type the name of the EX700i in the 
Search field and click Enter.

If you cannot locate the EX700i, contact your EX700i administrator.
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3 Double-click the name of the EX700i to display enabled print connections.

NOTE: For a description of each print connection, see Configuration and Setup.

4 Double-click the connection that you want to set up (print, hold, direct, or virtual printer).

The files are installed on your computer.

NOTE: You may receive a message that you are about to connect to a printer on the EX700i, 
which will automatically install a printer driver on your machine. Click Yes to continue.

5 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

The printer is displayed in the Printers or Printers and Faxes window.

6 Right-click the EX700i icon and choose Properties.

7 Click Print Test Page on the General tab.

If the Test Page prints successfully, you are ready to print from the computer.

8 Repeat the previous steps for the other connections that you want to set up.
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Downloading printer drivers using WebTools

WebTools allows you to download installers for printer drivers to your computer directly 
from the EX700i, if your administrator has enabled access to WebTools.

For information about Setup, see Configuration and Setup.

For information about setting up and starting WebTools, see Utilities.

TO DOWNLOAD PRINTER DRIVER FILES WITH WEBTOOLS

1 Start your Internet or intranet browser and type the DNS name or IP address of the EX700i.

2 Click the Downloads tab.

3 Click the link for the item that you want to install. 

For Windows printer drivers, click the Printer Files link under the Windows heading.

4 If a dialog box prompts you to open the file or save it to disk, choose to save it 
to disk.

5 Browse to the location where you want to save the PRNTDRV.EXE file and click Save.

The file is downloaded from the EX700i. This compressed file is an archive that contains 
multiple files.

6 Double-click the PRNTDRVE.EXE file to extract the files.

Depending on your operating system, you might be prompted to select a location to extract 
the files to.

Follow the instructions for your operating system to install the printer driver. The procedures 
are the same as for installing from the DVD, except that after you click Have Disk, you 
browse to the location where you extracted the files, rather than to the DVD.

For instructions on installing the Windows printer driver, see “To install and complete the 
print connection for Windows” on page 39.

For more information, see WebTools Downloads Help.
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Downloading printer drivers from the EX700i

You can download printer drivers files to your computer directly from the EX700i over the 
network, and then install them following the procedures in “Installing printer drivers from 
the User Software DVD” on page 39.

TO DOWNLOAD PRINTER DRIVER FILES FROM THE EX700I

1 Windows 2000/XP/Server 2003: Right-click Network Neighborhood or My Network Places, 
and then select Find Computer or Search for Computers.
Windows Vista/Server 2008: Click Start, choose Control Panel, double-click Network and 
Sharing Center, and then click the View computers and devices link.
Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, 
choose Network and Sharing Center, and then click the View network computers and devices 
link.

2 Windows 2000/XP/Server 2003: Type the name or IP address of the EX700i and click Search 
Now or Search.
Windows Vista/Windows 7/Server 2008/Server 2008 R2: Type the name of the EX700i in the 
Search field and click Enter.

If you cannot locate your EX700i, contact your administrator.

3 Double-click the name of the EX700i.

A folder named PC_User_SW is displayed, along with the enabled print connections.

4 Double-click the PC_User_SW folder and browse to the Print Drivers\Ps_drvr folder.

Follow the instructions for your operating system to install the printer driver. The procedures 
are the same as for installing from the DVD, except that after you click Have Disk, you 
browse to the Win_2K_XP_VISTA folder on your desktop, rather than to the DVD.
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Installing printer drivers from the User Software DVD

The following procedures describe installing the printer driver from the User Software DVD.

To install the printer driver on a Windows Server 2003/Server 2008/Server 2008 R2 or 
Windows 7 computer, select the same PPD (oemsetup.inf ) file as for Windows 2000/XP/
Vista, described in the following procedure.

NOTE: The following procedures use Windows XP illustrations. 

This procedure describes the installation of a local printer (Port 9100). You can modify the 
printing protocol later, according to your network type.

TO INSTALL AND COMPLETE THE PRINT CONNECTION FOR WINDOWS

1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.
Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, 
choose Network and Sharing Center, and then click the View network computers and devices 
link.

2 Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Double-click the Add a printer icon and click Next.
Windows Vista/Server 2008/Server 2008 R2/Windows 7: Click Add a printer.

3 Windows 2000/XP/Server 2003: Specify printing using a Local printer, clear the 
“Automatically detect and install my Plug and Play printer” option, and then click Next.
Windows Vista/Server 2008/Server 2008 R2/Windows 7: Select Add a local printer.

4 Select Create a New Port, choose Standard TCP/IP Port from the Type of port menu, and then 
click Next.

5 Windows 2000/XP/Server 2003: Click Next in the Welcome to the Add Standard TCP/IP 
Printer Port Wizard dialog box.

The Add Standard TCP/IP Printer Port Wizard dialog box appears. Proceed to step 6.

Windows Vista/Server 2008/Server 2008 R2/Windows 7: Select the Device Type, type the 
Hostname or IP address of the EX700i, and then click Next. Proceed to step 9.

6 Type the printer name or IP address of the EX700i and click Next. 

Windows 2000/Server 2003: Proceed to step 7.

Windows XP: Select the Device Type and click Next.

7 Windows 2000/XP/Server 2003: Make sure that Generic Network Card is selected as Standard 
for Device Type and click Next.
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8 Windows 2000/XP/Server 2003: Click Finish to close the Add Standard TCP/IP Printer Port 
Wizard dialog box.

NOTE: If the device is not found on the network, the device is displayed instead of the Finish 
button. If a device is not found on the network, that could be for one of the following 
reasons:

• EX700i is not powered on.

• Network is not connected.

• EX700i is not configured properly.

• IP address is not correct.

If you encounter one of these situations, you can continue to set up the port by configuring 
the port manually. See “To set up Standard TCP/IP Port (Raw or LPR) for Windows” on 
page 47 and follow steps 11 to 14 before proceeding to step 9.

9 Click Have Disk in the dialog box displaying lists of manufacturers and printers.

The Install From Disk dialog box prompts you for the disk.

10 Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for 
example, D:\), and then click Browse. Browse to the Print Drivers\Ps_drvr folder.

If you are installing from the files you downloaded from the EX700i using the Downloads tab 
in WebTools, browse to Print Drivers\Ps_drvr and click Open.

11 Make sure that “oemsetup.inf” or “oemsetup” is selected and click Open.

The path is copied to the Install From Disk dialog box.

12 Verify that the path is correct and click OK.

13 In the Printers box, select your printer and click Next.
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14 Type a name for the EX700i in the Printer name field, indicate whether you want to make it 
the default printer, and then click Next.

This name is used in the Printers window and the queues window.

15 Follow the on-screen instructions.

Do not share the printer and do not print a Test Page at this time. Continue with the printer 
driver installation and at the last screen, click Finish.

The necessary files are installed on your hard disk. When installation is complete, the Printers 
window appears with an icon for the newly installed printer. 

Now you are ready to configure the installable options (see “Configuring installable options” 
on page 53).

To set up a connection other than port 9100, proceed to “Setting up printing connections” 
on page 46.

To use the printer driver, you must select the following options on the Advanced tab of the 
printer driver after installation is complete:

• Spool print documents

• Start printing immediately

• Print spooled documents first
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Installing the printer driver on 64-bit Windows computer 
from a 32-bit Windows Server 2003 Server

If your network users print to the EX700i using Windows Server 2003 (32-bit) print sharing, 
and you have 64-bit Windows XP users on your network, you must add the 64-bit printer 
driver to the Windows Server 2003 (32-bit) computer, so that users can install the printer 
driver on their computers using Point and Print. We do not recommend installing the printer 
driver from a Server (32-bit) to Client (64-bit). When you install the 64-bit printer driver to 
the Server (32-bit), the Windows Server 2003 (64-bit) CD is required.

TO ADD THE 64-BIT PRINTER DRIVER TO A 32-BIT WINDOWS SERVER 2003 COMPUTER

1 Install the EX700i printer driver on the Windows Server 2003 computer.

For instructions, see “Installing printer drivers from the User Software DVD” on page 39. 
During the installation, when asked if you want to share the printer, select Yes.

2 In the Printer & Faxes window, right-click the printer that you just installed and choose 
Properties.

3 Click the Sharing tab and then click Additional Drivers.

4 Select the x64 components and click OK.

5 Browse to the printer driver files and select the oemsetup.inf file.

6 When prompted, insert the Windows Server 2003 x64 Installation CD on the Windows Server 
2003 computer.

7 On the CD, browse to the AMD64 folder and click OK.

The printer driver installation is complete.

Configuring installable options for printer drivers

If you install the printer driver from Add Printer Wizard and then use Two-Way 
Communication to configure the installable options, the installable options are not 
configured properly. After you install the printer driver, you must properly configure these 
options.

TO CORRECTLY CONFIGURE INSTALLABLE OPTIONS

1 After you install the printer driver, right-click the printer icon, choose Properties, click the 
Accessories tab, and then choose your installed options.

2 Click OK or Apply.
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Installing and connecting to a virtual printer

A virtual printer allows you to print to the EX700i using a predefined set of job settings. You 
do not have to set print options manually. Before you can print to a virtual printer, the 
administrator must create and configure the virtual printer using Command WorkStation. 
After the virtual printer is set up, you can install the printer driver and printer description files 
on your computer from the EX700i using Point and Print.

For more information about setting up virtual printers, see Command WorkStation Help.

When you install the printer driver using Point and Print, you cannot configure installable 
options manually. Installable options are configured automatically. The installed options are 
displayed in the printer driver when you select the Two-Way Communication option.

TO SET UP A VIRTUAL PRINTER ON WINDOWS COMPUTERS USING POINT AND PRINT

1 Windows 2000/XP/Server 2003: Right-click Network Neighborhood or My Network Places and 
select Find Computer or Search for Computers.
Windows Vista/Server 2008: Right-click Network and choose Open from the menu.
Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, 
choose Network and Sharing Center, and then click the View network computers and devices 
link.

2 Windows 2000/XP/Server 2003: Type the name or IP address of the EX700i and click Search 
Now or Search.
Windows Vista/Windows 7/Server 2008 R2: Type the name of the EX700i in the Search field 
and click Enter.
Windows Server 2008: Type the name or \\IP address of the EX700i in the Search field and 
click Enter.

If you cannot locate the EX700i, contact your network administrator.

3 Double-click the EX700i name to display enabled print connections.

Virtual printers are listed along with the Print queue, Hold queue, and Direct connection 
(if those connections are enabled). Virtual printers usually have names that indicate the type 
of job they are set up for.

4 Right-click the virtual printer that you want and choose Connect.

The files are installed on your computer.

5 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

The virtual printer is displayed in the Printers or Printers and Faxes window.



WINDOWS FOR EX700I PRINT SERVER 44

You can print to a virtual printer as you would print to the EX700i. Depending on how the 
virtual printer is configured, you may not be able to set some print options.

When you print to a virtual printer installed using Point and Print, you must open the 
Printing Preferences window and click OK before the job is printed. This applies the virtual 
printer settings to the job.

Enabling Two-Way Communication

You must enable Two-Way Communication to automatically update your printer driver to 
reflect the options currently installed on the digital press.

NOTE: You must log on with Administrator privileges to add or change the installable options 
after the Windows Vista, Windows 7, or Windows Server 2008 R2 printer driver is installed. 
For more information, see “Configuring installable options for Windows Vista/Windows 7/
Server 2008 R2 printer driver” on page 53.

TO ENABLE TWO-WAY COMMUNICATION

1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

2 Windows 2000/XP/Server 2003/Server 2008/Vista: Right-click the EX700i icon and choose 
Properties.
Windows 7/Server 2008 R2: Right-click the EX700i icon and choose Printer properties.

3 Click the Accessories tab.

4 Select Two-Way Communication.

5 Type the EX700i IP address or DNS name. 

6 Select Update Fiery Driver When Opened to display the printer’s current default settings 
when the printer driver is opened. 

7 Click Update.

NOTE: To confirm that Two-Way Communication is enabled, click the About tab and check 
that the EX700i name and other server information are displayed. 

8 Click OK.
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Uninstalling printer drivers

The Printer Delete Utility is installed and used locally. You do not need to connect to the 
EX700i before you use the software.

TO INSTALL AND USE THE FIERY PRINTER DELETE UTILITY

1 Insert the User Software DVD into the DVD drive of the computer.

2 In the window that appears, select Modify, and then click Next.

3 Select the Fiery Printer Delete Utility check box, and follow the on-screen instructions to 
install it.

4 Click Start, choose Programs or All Programs, and then choose Fiery. 

5 Choose PrinterDeleteUtility.

The Printer Delete Utility dialog box appears. Any EX700i printer drivers found on your 
computer are listed.

6 To delete a printer, select the check box next to the printer name and click Delete the 
Selected Printers.

To delete all the installed printer drivers, select the Delete All Printer Drivers check box.

7 Click OK to delete the selected printer driver(s).

8 When you finish deleting printer drivers, click Exit and restart your computer.
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Setting up the Windows computer for printing
Now that you the printer driver files are installed, you need to configure the proper 
connection for your networked EX700i printer.

To print from Windows computers, you or the administrator must perform the 
following tasks to set up a connection other than port 9100:

• Set up network servers, if any.

• Set up the EX700i to accept print jobs from your computer.

• Configure a port on each Windows computer for the network type.

Setting up printing connections

The EX700i supports the following printing connections:

• SMB

• Standard TCP/IP (RAW or LPR)

• IPP or IPP over SSL

For the location of each procedure, see the following table.

Completing the SMB printing connection

If your network does not have a Windows server, Windows computers can still print to the 
EX700i. This method of printing is SMB printing (also known as Windows or WINS 
printing). When users send print jobs, Windows computers operate in a peer-to-peer 
environment and communicate directly with the EX700i. 

Enabling SMB printing allows the EX700i to be listed on the network, so that Windows 
clients can print to a particular print connection (Print queue, Hold queue, Direct connection 
or Virtual Printer) on the EX700i without using other networking software. Windows 
printing runs via TCP/IP. You must configure TCP/IP on the EX700i and on all computers 
that use SMB printing.

After you enable SMB printing on the EX700i, you can set up the Windows or SMB 
connection and install the printer driver in one procedure. For more information, see 
“Installing printer drivers by Point and Print” on page 35.

Procedure See

Completing the SMB printing connection page 46

Completing Standard TCP/IP Port (Raw or LPR) printing connections page 47

Completing IPP connections page 50

Configuring installable options page 53
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Completing Standard TCP/IP Port (Raw or LPR) printing connections

After you install the PostScript and printer driver files, you can add or configure the Setup 
for the Standard TCP/IP Port (Raw or LPR) connection as follows:

• Prepare the EX700i to accept print jobs using Standard TCP/IP Port (Raw or LPR) 
protocols. 

• Enable LPD or Port 9100 on the EX700i. 

• Configure the computer for the TCP/IP connection.

For more information about Setup, see Configure Help.

Before you complete the following procedure, contact your system administrator for the 
IP address assigned to the EX700i.

The TCP/IP protocol should be installed as a default on the Windows computer. For Port 
9100, you can set up the connection and install the printer driver in one procedure.

NOTE: You can also set up the LPR Port connection by installing Print Services for UNIX, 
which is supplied as an add-on Windows component. For more information, see the 
documentation that accompanies Windows.

TO SET UP STANDARD TCP/IP PORT (RAW OR LPR) FOR WINDOWS

NOTE: The following procedures use Windows XP illustrations.

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista/Server 2008: Click Start, choose Control Panel, and then double-click Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

2 Windows 2000/XP/Server 2003/Server 2008/Vista: Right-click the EX700i icon and choose 
Properties.
Windows 7/Server 2008 R2: Right-click the EX700i icon and choose Printer properties.
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3 Click the Ports tab.

4 To add a new port, click Add Port.

To change the port settings, proceed to step 11. 

5 Windows 2000/XP/Server2003: Select Standard TCP/IP Port from the list of Available port 
types and click New Port Type.
Windows Vista/Server 2008: Double-click Standard TCP/IP Port from the list.
Windows 7/Server 2008 R2: Select Standard TCP/IP Port from the list of Available port types 
and click New Port. 

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

6 Click Next. 
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7 Type the EX700i IP address. 

8 Click Next.

9 Make sure that Generic Network Card is selected as Standard for Device Type and click Next.

10 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click 
Close in the Printer Ports dialog box.

To change the default setting, proceed to step 11. 

If you do not want to change the default setting, the setting is now completed.

NOTE: Port 9100 was set as the default setting in the preceding procedure.

11 Click Configure Port on the Ports tab of the Properties dialog box.

The Configure Standard TCP/IP Port Monitor dialog box appears.
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12 To use LPR printing, select LPR in the Protocol area and LPR Byte Counting Enabled in the LPR 
Settings area.

NOTE: You can also proceed without selecting LPR Byte Counting Enabled.

To use Port 9100 printing, select Raw in the Protocol area. 

The port number 9100 automatically appears in the Raw Settings area. This is the default 
port number. You can print to the printer connection selected for Port 9100 printing on the 
EX700i.

To specify a specific port number, see the following step.

13 Type the name of the print connection.

For Port 9100, type the following port numbers for each print connection in the Raw Settings 
area:

EX700i default: 9100

direct: 9101

print: 9102

hold: 9103

NOTE: Type the number exactly as shown.

14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

NOTE: The EX700i supports printing in the IPv6 environment on Windows Server 2008/
Server 2008 R2, Windows 7, and Windows Vista. 

NOTE: LPR printing in the IPv6 environment is supported on the Windows XP/Server 2003 
computer from a command line, but other methods may work.

15 Click Apply in the EX700i Properties dialog box, and then click OK.

Completing IPP connections

With Internet Printing Protocol (IPP), print jobs are sent to the EX700i over the Internet.

Before you begin, perform the following tasks:

• Make sure that the EX700i is configured for TCP/IP printing and IPP printing. 

For more information, see Configure Help.

• Specify the printing destination on your computer.

NOTE: IPP over SSL connections is supported.
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TO SET UP IPP PRINTING WITH WINDOWS

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and then double-click Printers under 
Classic View.
Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, 
choose Network and Sharing Center, and then click the View network computers and devices 
link.

2 Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Double-click the Add a printer icon and click Next.
Windows Vista/Server 2008/Server 2008 R2/Windows 7: Click Add a printer.

3 Windows 2000/XP/Server 2003: Select Network printer and click Next.
Windows Vista: Select Add a network printer.
Windows Server 2008/Server 2008 R2/Windows 7: Select Add a network, wireless, or 
Bluetooth printer.

4 Windows 2000/XP/Server 2003/Vista: Select Connect to a printer on the Internet or 
your intranet.
Windows Server 2008/Server 2008 R2/Windows 7: If the printer search takes a long time, 
click Stop, and then click “The printer that I want isn’t listed.”

5 Windows 2000/XP/Server 2003/Vista: In the URL field, type the IP address or DNS name of 
the EX700i, followed by “ipp/”and then the name of the connection (hold, direct, print, or 
name of virtual printer).

For example, http://10.10.10.150/ipp/print or http://DNS name of the EX700i/ipp/print 
sends the job to the Print queue on the EX700i. 

For IPP over SSL, type https, instead of http.

NOTE: The ipp/print in the example is case sensitive.
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Windows Server 2008/Server 2008 R2/Windows 7: Click Select a printer by name, and in the 
URL field, type the IP address or DNS name of the EX700i, followed by the name of the 
connection (print, hold, or direct).

NOTE: For example, http://10.10.10.150/ipp/print or http://DNS name of EX700i/ipp/print 
sends the job to the Print queue on the EX700i.

NOTE: The URL for the printer is not case-sensitive. 

6 Windows 2000/XP/Server 2003/Vista: Click Next.

The Connect to Printer dialog box appears.

Windows Server 2008/Server 2008 R2/Windows 7: Click Next.

7 Windows 2000/XP/Server 2003/Vista: Click OK.

The Add Printer Wizard dialog box appears. 

Windows Server 2008/Server 2008 R2/Windows 7: Click Install driver.

8 If you are installing the PostScript printer for the first time, follow the procedure “To install 
and complete the print connection for Windows” on page 39, step 9.

9 Indicate whether you want to make the EX700i the default printer and click Next.

10 Click Finish.
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Configuring installable options

After you complete the printer driver installation, you must configure the EX700i for the 
options installed on the digital press to allow the EX700i to take advantage of the digital press 
options. Configure the options manually, or for TCP/IP network connections, use the 
Two-Way Communication option to configure the options automatically.

For information about specifying installable options, see printer driver Help.

Configuring installable options for Windows Vista/Windows 7/Server 2008 R2 
printer driver

Windows Vista, Windows 7, and Windows Server 2008 R2 have a User Account Control 
(UAC) feature. You must log on with Administrator privileges to add or change the installable 
options after the printer driver is installed.

TO CHANGE INSTALLABLE OPTIONS

1 Windows Vista: Open the Printers Control Panel.
Windows 7/Server 2008 R2: Open the Devices and Printers Control Panel.

2 Windows Vista: Right-click the EX700i printer icon, choose Run as administrator, and then 
choose Properties.
Windows 7/Server 2008 R2: Right-click the EX700i printer icon, choose Run as administrator, 
and then choose Printer properties.

The User Account Control dialog box opens. 

3 Choose the User that has administrator privileges, type the password, and then click OK. 

4 Windows Vista: Right-click the EX700i printer icon again and choose Properties.
Windows 7/Server 2008 R2: Right-click the EX700i printer icon again and choose Printer 
properties.

5 Click the Accessories tab and make your selections.

6 Click Apply, and then click OK.
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Printing from Windows computers
You can print to the EX700i just as you would print to any other printer from a Windows 
application. You can print from a networked Windows computer or a computer using 
Windows (WINS) printing. Select the EX700i as the current printer in the Printer Name list, 
specify print options, and then print the document from the application.

The following table includes other methods to print to the EX700i and describes where to 
find information about these features.

NOTE: The following procedures use Windows XP illustrations, unless specified.

For more information See

Downloading files to the EX700i using the Docs WebTool  Utilities

Printing documents using E-mail Services “E-mail Service” on 
page 87

Printing documents using Hot Folders  Utilities

Printing documents using Command WorkStation  Utilities

Setting up the Windows environment for printing 
with Windows servers connected to the EX700i

 Configuration and Setup

Achieving optimal printing results from applications Color Printing and Fiery 
Color Reference

Setting print options and printing from Windows applications page 55

Specifying default print options page 58

Customizing the Quick Access icon page 59

Viewing the digital press status page 59

Saving files to print to a remote location page 59

Defining and printing custom page sizes page 129
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Setting print options and printing from Windows applications

To print from Windows platforms, install the PostScript printer driver. For instructions, see 
“Installing Windows printer drivers” on page 34. Be sure to configure the options on the 
Advanced tab of the printer driver after installation is complete, as described on page 39.

If you print to a virtual printer, you may not be able to set some print options, depending on 
how the virtual printer is configured.

Some print options that are selectable from an application are similar to print options that are 
specific to the EX700i and the digital press. In these cases, use the print options specific to the 
EX700i and the digital press. These options appear in the Fiery Printing tab. The application 
may not set up the file properly for printing on the EX700i, resulting in unexpected finishing, 
printing errors, or longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box 
provides instructions to resolve the conflict.

Some print options, such as expert color settings, are available only if Two-Way 
Communication is enabled or a particular installable option is configured. For information 
about enabling Two-Way Communication, see printer driver Help. For information about 
configuring installable options, see “Configuring installable options” on page 53.

If you choose Printer’s default, the job prints according to the settings that the administrator 
specified in Setup. For more information, see page 99.

The following procedures explain how to use the printer driver to specify print options for a 
particular job and print it to the EX700i. You can also set default print settings using the 
driver. For information about print options, see page 98.

NOTE: The following procedures use Windows XP illustrations.
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TO SET PRINT OPTIONS FOR A SPECIFIC WINDOWS PRINT JOB USING THE PRINTER DRIVER

1 In your application, choose File > Print, and select the EX700i as your printer.

2 Click Properties.

3 Click the Fiery Printing tab.

The Fiery Printing tab serves as the control center for all frequently used printing functions. 

For information about using presets, see printer driver Help.

NOTE: For a list of print options, see page 100.

1 Presets (Job Templates), 
see Help

2 Print Option icons
3 Customize (Shortcuts), 

see Help
4 Active area
5 Job View
6 Printer Status
7 Help

1

2

3

5

6

4

7
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4 Specify print options and settings for your job.

The print options are grouped by categories. Each group or tab contains print options that are 
similar or complement one another.

The groups or tabs are as follows:

Quick Access contains duplicate print options from the other job properties groups. It is 
customizable, so any Job Override print option can be added or removed from the view. The 
Quick Access tab lets you find print options quickly without having to browse through all the 
Properties tabs. For information about customizing the Quick Access view, see page 59.

Job Info contains all information about the job, including user information that may be 
required for user authentication, secure print properties, job handling, and document server. 
For information about Job Info options, see page 101.

Media contains attributes and sources of paper to print and insert. For information about 
Media options, see page 103.

Layout defines how the file is positioned or imaged on the media/sheet, except for positioning 
that compensates for finishing options, for example, Tray Alignment. For information about 
Layout options, see page 106.

Color contains color settings and graphic arts features (when enabled). For information about 
Color options, see page 111.

Image contains all Image Quality settings supported by the connected EX700i and digital 
press. For information about Image options, see page 116.

Finishing contains print options that are specific to the EX700i and to the finishing 
equipment on the digital press. These options override settings in EX700i Printer Setup but 
can be changed from Command WorkStation. For information about Finishing options, see 
page 117. 

VDP contains all Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP 
settings. For information about VDP options, see page 119.

Stamping contains any image stamping option that adds or hides/removes any image on the 
job. This also includes watermark properties that define the placement and style of the 
watermark. For information about Stamping/Watermark options, see page 120 or printer 
driver Help.

Printer contains digital press status that includes the current paper and dry ink levels. For 
more information, see page 59 or printer driver Help.

5 After you specify the print settings, click Print to send your print job.
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Specifying default print options for print jobs

To set default print options, use the following procedure.

TO SET DEFAULT PRINT OPTIONS FOR WINDOWS PRINT JOBS USING THE POSTSCRIPT PRINTER DRIVER

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista/Server 2008: Click Start, choose Control Panel, and then double-click Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

2 Right-click the EX700i icon and choose Printing Preferences.

3 If the Fiery Printing tab is not displayed, click it.

4 Specify the default settings for your print job, as described on page 56.

5 Click OK to close the dialog box.
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Customizing the Quick Access icon

The Quick Access view can be customized with the print options that you use frequently. 
This saves time because you do not have to open all of the other print option icons if you only 
want to set the options in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option 
icon. You can set the option from either location.

TO CUSTOMIZE QUICK ACCESS

1 In your application, choose File > Print, and select the EX700i as your printer.

2 Click Properties.

3 Click the Fiery Printing tab.

4 Click Customize to specify the options shown in the Customize Quick Access dialog box.

You can select a shortcut from the Available Shortcuts list and add it to the Current Shortcuts 
list, as well as remove a shortcut from the Current Shortcuts list. Click OK to save your 
changes.

For more information about customizing the Quick Access icon, see printer driver Help.

Viewing the digital press status

If you enable a TCP/IP network, you can retrieve the digital press status and color settings 
from the EX700i and display them in the printer driver with the Two-Way Communication 
option. If you enable Two-Way Communication for your digital press, you can monitor the 
status of the digital press, including the levels of consumable materials, such as paper and dry 
ink.

For more information about enabling Two-Way Communication, see printer driver Help.

Saving files to print at a remote location

If you do not have an EX700i onsite and are preparing files for a service bureau or other 
location, print the final files to the File port (as opposed to one of the local ports). You can 
also print to the File port to create a file to download using the Docs WebTool. For 
instructions on printing to the File port, see the documentation that accompanies Windows.
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WINDOWS FOR INTEGRATED FIERY COLOR SERVER

To set up the EX700i as a digital press on a Windows computer, install the printer driver files 
that correspond to your digital press and set up the EX700i for printing. Printer drivers 
provide a way to communicate information about print jobs between your applications, the 
EX700i, and the digital press.

For the location of each procedure, see the following table.

Installing Windows printer drivers
Installing printer drivers and printer description files is the first step in setting up the EX700i 
as a PostScript printer.

NOTE: Windows Vista, Windows 7, and Windows Server 2008 R2 have a User Account 
Control (UAC) feature. You must be the administrator or a user with administrator privileges 
to install printer drivers.

NOTE: If the EX700i printer driver is already installed, you must uninstall it before you install 
a new driver (see “Uninstalling printer drivers” on page 70).

The following sections describe how to install the printer files for the EX700i.

Procedure See

Installing Windows printer drivers page 60

Setting up the Windows computer for printing page 71

Printing from Windows computers page 79

Procedure See

Installing printer drivers by Point and Print page 61

Downloading printer drivers using WebTools page 63

Installing printer drivers from the User Software DVD page 64

Installing the printer driver on 64-bit Windows computer
from a 32-bit Windows Server 2003 Server

page 67

Installing and connecting to a virtual printer page 68

Uninstalling printer drivers page 70
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Installing printer drivers by Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript 
printer drivers on your computer from the EX700i using Point and Print, and print to a 
particular connection (Print queue, Hold queue, Direct connection, or Virtual Printer).

Each connection (print, hold, direct or virtual printer) requires a separate installation. Repeat 
the procedure for each connection.

When you install the printer driver using Point and Print, you cannot configure installable 
options manually. The installed options are displayed as the EX700i configuration in the 
printer driver. For more information, see “Configuring installable options” on page 78.

BEFORE YOU BEGIN

Ask your administrator to do the following in Setup on the EX700i:

• Assign the EX700i a valid IP address.

Ask your administrator for the IP address or DNS name required in the following procedure.

• Configure the EX700i for SMB printing.

NOTE: SMB printing is referred to as Windows Printing in Setup and on the Configuration 
page. 

For more information, see Configuration and Setup or Configure Help.

TO SET UP SMB PRINTING ON WINDOWS COMPUTERS

1 Windows 2000/XP/Server 2003: Right-click Network Neighborhood or My Network Places, and 
then select Find Computer or Search for Computers.
Windows Vista/Server 2008: Click Start, choose Control Panel, double-click Network and 
Sharing Center, and then click the View computers and devices link.
Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, 
choose Network and Sharing Center, and then click the View network computers and devices 
link.

2 Windows 2000/XP/Server 2003: Type the name or IP address of the EX700i and click Search 
Now or Search.
Windows Vista/Windows 7/Server 2008/Server 2008 R2: Type the name of the EX700i in the 
Search field and click Enter.

If you cannot locate the EX700i, contact your EX700i administrator.
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3 Double-click the name of the EX700i to display enabled print connections.

NOTE: For a description of each print connection, see Configuration and Setup.

You must now create a printer port and install the printer driver from the User Software 
DVD.

NOTE: You cannot use Point and Print to install the driver and configure the printing 
connection to the EX700i in a single procedure.

4 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click the Start button, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click the Start button, choose Control Panel, and under Classic View, 
double-click Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

5 On Windows XP: Double-click the Add Printer icon and click Next.
On Windows Server 2003: Double-click the Add a printer icon and click Next.
Windows Vista/Server 2008/Server2008 R2/Windows 7: Click Add a printer.

6 Click Local Printer and click Next.

7 Click Create a New Port, choose Local Port from the menu, and then click Next.

8 In the Port Name dialog box, type the name of the EX700i, followed by the printing 
connection, and click OK.

Enter the port name as follows: \\Aero\print where Aero is the name of the EX700i and print 
is the printing connection.

9 In the dialog box displaying lists of manufacturers and printers, click Have Disk.

You will now install the printer driver from the User Software DVD.

10 Type the name of the DVD drive and browse to the Print Drivers\Ps_drvr folder. 

11 Make sure “oemsetup.inf” or “oemsetup” is selected and click Open.

12 Verify the path is correct in the Install From Disk dialog box and click OK.

13 Follow the on-screen instructions.
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Downloading printer drivers using WebTools

WebTools allows you to download installers for printer drivers to your computer directly from 
the EX700i, if your administrator has enabled access to WebTools.

For information about Setup, see Configuration and Setup.

For information about setting up and starting WebTools, see Utilities.

TO DOWNLOAD PRINTER DRIVER FILES WITH WEBTOOLS

1 Start your Internet or intranet browser and type the DNS name or IP address of the EX700i.

2 Click the Downloads tab.

3 Click the link for the item that you want to install. 

For Windows printer drivers, click the Printer Files link under the Windows heading.

4 If a dialog box prompts you to open the file or save it to disk, choose to save it 
to disk.

5 Browse to the location where you want to save the PRNTDRVE.EXE file and click Save.

The file is downloaded from the EX700i. This compressed file is an archive that contains 
multiple files.

6 Double-click the PRNTDRV.EXE file to extract the files.

Depending on your operating system, you might be prompted to select a location to extract 
the files to.

Follow the instructions for your operating system to install the printer driver. The procedures 
are the same as for installing from the DVD, except that after you click Have Disk, you 
browse to the location where you extracted the files, rather than to the DVD.

For instructions on installing the Windows printer driver, see “To install and complete the 
print connection for Windows” on page 64.

For more information, see WebTools Downloads Help.
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Installing printer drivers from the User Software DVD

The following procedures describe installing the printer driver from the User Software DVD.

To install the printer driver on a Windows Server 2003/Server 2008/Server 2008 R2 or 
Windows 7 computer, select the same PPD (oemsetup.inf ) file as for Windows 2000/XP/
Vista, described in the following procedure.

NOTE: The following procedures use Windows XP illustrations. 

This procedure describes the installation of a local printer (Port 9100). You can modify the 
printing protocol later, according to your network type.

TO INSTALL AND COMPLETE THE PRINT CONNECTION FOR WINDOWS

1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.
Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, 
choose Network and Sharing Center, and then click the View network computers and devices 
link.

2 Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Double-click the Add a printer icon and click Next.
Windows Vista/Server 2008/Server 2008 R2/Windows 7: Click Add a printer.

3 Windows 2000/XP/Server 2003: Specify printing using a Local printer, clear the 
“Automatically detect and install my Plug and Play printer” option, and then click Next.
Windows Vista/Server 2008/Server 2008 R2/Windows 7: Select Add a local printer.

4 Select Create a New Port, choose Standard TCP/IP Port from the Type of port menu, and then 
click Next.

5 Windows 2000/XP/Server 2003: Click Next in the Welcome to the Add Standard TCP/IP Printer 
Port Wizard dialog box.

The Add Standard TCP/IP Printer Port Wizard dialog box appears. Proceed to step 6.

Windows Vista/Server 2008/Server 2008 R2/Windows 7: Select the Device Type, type the 
Hostname or IP address of the EX700i, and then click Next. Proceed to step 9.

6 Type the printer name or IP address of the EX700i and click Next. 

Windows 2000/Server 2003: Proceed to step 7.

Windows XP: Select the Device Type and click Next.

7 Windows 2000/XP/Server 2003: Make sure that Generic Network Card is selected as Standard 
for Device Type and click Next.
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8 Windows 2000/XP/Server 2003: Click Finish to close the Add Standard TCP/IP Printer Port 
Wizard dialog box.

NOTE: If the device is not found on the network, the device is displayed instead of the Finish 
button. If a device is not found on the network, that could be for one of the following 
reasons:

• EX700i is not powered on.

• Network is not connected.

• EX700i is not configured properly.

• IP address is not correct.

If you encounter one of these situations, you can continue to set up the port by configuring 
the port manually. See “To set up Standard TCP/IP Port (Raw or LPR) for Windows” on 
page 72 and follow steps 11 to 14 before proceeding to step 9.

9 Click Have Disk in the dialog box displaying lists of manufacturers and printers.

The Install From Disk dialog box prompts you for the disk.

10 Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for 
example, D:\), and then click Browse. Browse to the Print Drivers\Ps_drvr folder.

If you are installing from the files you downloaded from the EX700i using the Downloads tab 
in WebTools, browse to Print Drivers\Ps_drvr and click Open.

11 Make sure that “oemsetup.inf” or “oemsetup” is selected and click Open.

The path is copied to the Install From Disk dialog box.

12 Verify that the path is correct and click OK.

13 In the Printers box, select your printer and click Next.
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14 Type a name for the EX700i in the Printer name field, indicate whether you want to make it 
the default printer, and then click Next.

This name is used in the Printers window and the queues window.

15 Follow the on-screen instructions.

Do not share the printer and do not print a Test Page at this time. Continue with the printer 
driver installation and at the last screen, click Finish.

The necessary files are installed on your hard disk. When installation is complete, the Printers 
window appears with an icon for the newly installed printer. 

Now you are ready to configure the installable options (see “Configuring installable options” 
on page 78).

To set up a connection other than port 9100, proceed to “Setting up printing connections” 
on page 71.

To use the printer driver, you must select the following options on the Advanced tab of the 
printer driver after installation is complete:

• Spool print documents

• Start printing immediately

• Print spooled documents first
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Installing the printer driver on 64-bit Windows computer from a 
32-bit Windows Server 2003 Server

If your network users print to the EX700i using Windows Server 2003 (32-bit) print sharing, 
and you have 64-bit Windows XP users on your network, you must add the 64-bit printer 
driver to the Windows Server 2003 (32-bit) computer, so that users can install the printer 
driver on their computers using Point and Print. We do not recommend installing the printer 
driver from a Server (32-bit) to Client (64-bit). When you install the 64-bit printer driver to 
the Server (32-bit), the Windows Server 2003 (64-bit) CD is required.

TO ADD THE 64-BIT PRINTER DRIVER TO A 32-BIT WINDOWS SERVER 2003 COMPUTER

1 Install the EX700i printer driver on the Windows Server 2003 computer.

For instructions, see “Installing printer drivers from the User Software DVD” on page 64. 
During the installation, when asked if you want to share the printer, select Yes.

2 In the Printer & Faxes window, right-click the printer that you just installed and choose 
Properties.

3 Click the Sharing tab and click Additional Drivers.

4 Select the x64 components and click OK.

5 Browse to the printer driver files and select the oemsetup.inf file.

6 When prompted, insert the Windows Server 2003 x64 Installation CD into the Windows Server 
2003 computer.

7 On the CD, browse to the AMD64 folder and click OK.

The printer driver installation is complete.

Configuring installable options for printer drivers

If you install the printer driver from Add Printer Wizard and then use Two-Way 
Communication to configure the installable options, the installable options are not 
configured properly. After you install the printer driver, you must properly configure these 
options.

TO CORRECTLY CONFIGURE INSTALLABLE OPTIONS

1 After you install the printer driver, right-click the printer icon, choose Properties, click the 
Accessories tab, and then choose your installed options.

2 Click OK or Apply.
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Installing and connecting to a virtual printer

A virtual printer allows you to print to the EX700i using a predefined set of job settings. You 
do not have to set print options manually. Before you can print to a virtual printer, the 
administrator must create and configure the virtual printer using Command WorkStation. 
After the virtual printer is set up, you can install the printer driver and printer description files 
on your computer from the EX700i using Point and Print.

For more information about setting up virtual printers, see Command WorkStation Help.

When you install the printer driver using Point and Print, you cannot configure installable 
options manually. Installable options are configured automatically. The installed options are 
displayed in the printer driver when you select the Two-Way Communication option.

TO SET UP A VIRTUAL PRINTER ON WINDOWS COMPUTERS USING POINT AND PRINT

1 Windows 2000/XP/Server 2003: Right-click Network Neighborhood or My Network Places and 
select Find Computer or Search for Computers.
Windows Vista/Server 2008: Right-click Network and choose Open from the menu.
Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, 
choose Network and Sharing Center, and then click the View network computers and devices 
link.

2 Windows 2000/XP/Server 2003: Type the name or IP address of the EX700i and click Search 
Now or Search.
Windows Vista/Windows 7/Server 2008 R2: Type the name of the EX700i in the Search field 
and click Enter.
Windows Server 2008: Type the name or \\IP address of the EX700i in the Search field and 
click Enter.

If you cannot locate the EX700i, contact your network administrator.

3 Double-click the EX700i name to display enabled print connections.

Virtual printers are listed along with the Print queue, Hold queue, and Direct connection 
(if those connections are enabled). Virtual printers usually have names that indicate the type 
of job they are set up for.

4 Right-click the virtual printer that you want and choose Connect.

The files are installed on your computer.

5 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

The virtual printer is displayed in the Printers or Printers and Faxes window.
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You can print to a virtual printer as you would print to the EX700i. Depending on how the 
virtual printer is configured, you may not be able to set some print options.

When you print to a virtual printer installed using Point and Print, you must open the 
Printing Preferences window and click OK before the job is printed. This applies the virtual 
printer settings to the job.

Enabling Two-Way Communication

You must enable Two-Way Communication to automatically update your printer driver to 
reflect the options currently installed on the digital press.

NOTE: You must log on with Administrator privileges to add or change the installable options 
after the Windows Vista, Windows 7, or Windows Server 2008 R2 printer driver is installed. 
For more information, see “Configuring installable options for Windows Vista/Windows 7/
Server 2008 R2 printer driver” on page 78.

TO ENABLE TWO-WAY COMMUNICATION

1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click 
Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

2 Windows 2000/XP/Server 2003/Server 2008/Vista: Right-click the EX700i icon and choose 
Properties.
Windows 7/Server 2008 R2: Right-click the EX700i icon and choose Printer properties.

3 Click the Accessories tab.

4 Select Two-Way Communication.

5 Type the EX700i IP address or DNS name. 

6 Select Update Fiery Driver When Opened to display the printer’s current default settings when 
the printer driver is opened. 

7 Click Update.

NOTE: To confirm that Two-Way Communication is enabled, click the About tab and check 
that the EX700i name and other server information are displayed. 

8 Click OK.
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Uninstalling printer drivers

The Printer Delete Utility is installed and used locally. You do not need to connect to the 
EX700i before you use the software.

TO INSTALL AND USE THE FIERY PRINTER DELETE UTILITY

1 Insert the User Software DVD into the DVD drive of the computer.

2 In the window that appears, select Modify, and then click Next.

3 Select the Fiery Printer Delete Utility check box, and follow the on-screen instructions to 
install it.

4 Click Start, choose Programs or All Programs, and then choose Fiery. 

5 Choose PrinterDeleteUtility.

The Printer Delete Utility dialog box appears. Any EX700i printer drivers found on your 
computer are listed.

6 To delete a printer, select the check box next to the printer name and click Delete the 
Selected Printers.

To delete all the installed printer drivers, select the Delete All Printer Drivers check box.

7 Click OK to delete the selected printer driver(s).

8 When you finish deleting printer drivers, click Exit and restart your computer.
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Setting up the Windows computer for printing
Now that the printer driver files are installed, you need to configure the proper connection for 
your networked EX700i printer.

To print from Windows computers, you or the administrator must perform the 
following tasks to set up a connection other than port 9100:

• Set up network servers, if any.

• Set up the EX700i to accept print jobs from your computer.

• Configure a port on each Windows computer for the network type.

Setting up printing connections

The EX700i supports the following printing connections:

• SMB

• Standard TCP/IP (RAW or LPR)

• IPP or IPP over SSL

For the location of each procedure, see the following table.

Completing the SMB printing connection

If your network does not have a Windows server, Windows computers can still print to the 
EX700i. This method of printing is SMB printing (also known as Windows or WINS 
printing). When users send print jobs, Windows computers operate in a peer-to-peer 
environment and communicate directly with the EX700i. 

Enabling SMB printing allows the EX700i to be listed on the network, so that Windows 
clients can print to a particular print connection (Print queue, Hold queue, Direct connection 
or Virtual Printer) on the EX700i without using other networking software. Windows 
printing runs via TCP/IP. You must configure TCP/IP on the EX700i and on all computers 
that use SMB printing.

After you enable SMB printing on the EX700i, you can set up the Windows or SMB 
connection and install the printer driver in one procedure. For more information, see 
“Installing printer drivers by Point and Print” on page 61.

Procedure See

Completing the SMB printing connection page 71

Completing Standard TCP/IP Port (Raw or LPR) printing connections page 72

Completing IPP connections page 75

Configuring installable options page 78
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Completing Standard TCP/IP Port (Raw or LPR) printing connections

After you install the PostScript and printer driver files, you can add or configure the Setup 
for the Standard TCP/IP Port (Raw or LPR) connection as follows:

• Prepare the EX700i to accept print jobs using Standard TCP/IP Port (Raw or LPR) 
protocols. 

• Enable LPD or Port 9100 on the EX700i. 

• Configure the computer for the TCP/IP connection.

For more information about Setup, see Configure Help.

Before you complete the following procedure, contact your system administrator for the 
IP address assigned to the EX700i.

The TCP/IP protocol should be installed as a default on the Windows computer. For Port 
9100, you can set up the connection and install the printer driver in one procedure.

NOTE: You can also set up the LPR Port connection by installing Print Services for UNIX, 
which is supplied as an add-on Windows component. For more information, see the 
documentation that accompanies Windows.

TO SET UP STANDARD TCP/IP PORT (RAW OR LPR) FOR WINDOWS

NOTE: The following procedures use Windows XP illustrations.

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista/Server 2008: Click Start, choose Control Panel, and then double-click Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

2 Windows 2000/XP/Server 2003/Server 2008/Vista: Right-click the EX700i icon and choose 
Properties.
Windows 7/Server 2008 R2: Right-click the EX700i icon and choose Printer properties.
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3 Click the Ports tab.

4 To add a new port, click Add Port.

To change the port settings, proceed to step 11. 

5 Windows 2000/XP/Server2003: Select Standard TCP/IP Port from the list of Available port 
types and click New Port Type.
Windows Vista/Server 2008: Double-click Standard TCP/IP Port from list.
Windows 7/Server 2008 R2: Select Standard TCP/IP Port from the list of Available port types 
and click New Port. 

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

6 Click Next. 
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7 Type the EX700i IP address. 

8 Click Next.

9 Make sure that Generic Network Card is selected as Standard for Device Type and click Next.

10 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click 
Close in the Printer Ports dialog box.

To change the default setting, proceed to step 11. 

If you do not want to change the default setting, the setting is now completed.

NOTE: Port 9100 was set as the default setting in the preceding procedure.

11 Click Configure Port on the Ports tab of the Properties dialog box.

The Configure Standard TCP/IP Port Monitor dialog box appears.
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12 To use LPR printing, select LPR in the Protocol area and LPR Byte Counting Enabled in the LPR 
Settings area.

NOTE: You can also proceed without selecting LPR Byte Counting Enabled.

To use Port 9100 printing, select Raw in the Protocol area. 

The port number 9100 automatically appears in the Raw Settings area. This is the default 
port number. You can print to the printer connection selected for Port 9100 printing on the 
EX700i.

To specify a specific port number, see the following step.

13 Type the name of the print connection.

For LPR, type print, hold, direct or published virtual printer name for Queue Name.

For Port 9100, type the following port numbers for each print connection in the Raw Settings 
area:

EX700i default: 9100

direct: 9101

print: 9102

hold: 9103

NOTE: Type the number exactly as shown.

14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

NOTE: The EX700i supports printing in the IPv6 environment on Windows Server 2008/
Server 2008 R2, Windows 7, and Windows Vista. 

NOTE: LPR printing in the IPv6 environment is supported on the Windows XP/Server 2003 
computer from a command line, but other methods may work.

15 Click Apply in the EX700i Properties dialog box, and then click OK.

Completing IPP connections

With Internet Printing Protocol (IPP), print jobs are sent to the EX700i over the Internet.

Before you begin, perform the following tasks:

• Make sure that the EX700i is configured for TCP/IP printing and IPP printing. 

For more information, see Configure Help.

• Specify the printing destination on your computer.

NOTE: IPP over SSL connections is supported.
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TO SET UP IPP PRINTING WITH WINDOWS

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows Server 2008: Click Start, choose Control Panel, and then double-click Printers under 
Classic View.
Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, 
choose Network and Sharing Center, and then click the View network computers and devices 
link.

2 Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Double-click the Add a printer icon and click Next.
Windows Vista/Server 2008/Server 2008 R2/Windows 7: Click Add a printer.

3 Windows 2000/XP/Server 2003: Select Network printer and click Next.
Windows Vista: Select Add a network printer.
Windows Server 2008/Server 2008 R2/Windows 7: Select Add a network, wireless, or 
Bluetooth printer.

4 Windows 2000/XP/Server 2003/Vista: Select Connect to a printer on the Internet or 
your intranet.
Windows Server 2008/Server 2008 R2/Windows 7: If the printer search takes a long time, 
click Stop, and then click “The printer that I want isn’t listed.”

5 Windows 2000/XP/Server 2003/Vista: In the URL field, type the IP address or DNS name of 
the EX700i, followed by “ipp/” and then the name of the connection (hold, direct, print, or 
name of virtual printer).

For example, http://10.10.10.150/ipp/print or http://DNS name of the EX700i/ipp/print 
sends the job to the Print queue on the EX700i. 

For IPP over SSL, type https, instead of http.

NOTE: The ipp/print in the example is case sensitive.
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Windows Server 2008/Server 2008 R2/Windows 7: Click Select a printer by name, and in the 
URL field, type the IP address or DNS name of the EX700i, followed by the name of the 
connection (print, hold, or direct).

NOTE: For example, http://10.10.10.150/ipp/print or http://DNS name of EX700i/ipp/print 
sends the job to the Print queue on the EX700i.

NOTE: The URL for the printer is not case-sensitive. 

6 Windows 2000/XP/Server 2003/Vista: Click Next.

The Connect to Printer dialog box appears.

Windows Server 2008/Server 2008 R2/Windows 7: Click Next.

7 Windows 2000/XP/Server 2003/Vista: Click OK.

The Add Printer Wizard dialog box appears. 

Windows Server 2008/Server 2008 R2/Windows 7: Click Install driver.

8 If you are installing the PostScript printer for the first time, follow the procedure “To install 
and complete the print connection for Windows” on page 64, step 9.

9 Indicate whether you want to make the EX700i the default printer and click Next.

10 Click Finish.
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Configuring installable options

After you complete the printer driver installation, you must configure the EX700i for the 
options installed on the digital press to allow the EX700i to take advantage of the digital press 
options. Configure the options manually, or for TCP/IP network connections, use the 
Two-Way Communication option to configure the options automatically.

For information about specifying installable options, see printer driver Help.

Configuring installable options for Windows Vista/Windows 7/Server 2008 R2 
printer driver

Windows Vista, Windows 7, and Windows Server 2008 R2 have a User Account Control 
(UAC) feature. You must log on with Administrator privileges to add or change the installable 
options after the printer driver is installed.

TO CHANGE INSTALLABLE OPTIONS

1 Windows Vista: Open the Printers Control Panel.
Windows 7/Server 2008 R2: Open the Devices and Printers Control Panel.

2 Windows Vista: Right-click the EX700i printer icon, choose Run as administrator, and then 
choose Properties.
Windows 7/Server 2008 R2: Right-click the EX700i printer icon, choose Run as administrator, 
and then choose Printer properties.

The User Account Control dialog box opens. 

3 Choose the User that has administrator privileges, type the password, and then click OK. 

4 Windows Vista: Right-click the EX700i printer icon again and choose Properties.
Windows 7/Server 2008 R2: Right-click the EX700i printer icon again and choose Printer 
properties.

5 Click the Accessories tab and make your selections.

6 Click Apply, and then click OK.
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Printing from Windows computers
You can print to the EX700i just as you would print to any other printer from a Windows 
application. You can print from a networked Windows computer or a computer using 
Windows (WINS) printing. Select the EX700i as the current printer in the Printer Name list, 
specify print options, and then print the document from the application.

The following table includes other methods to print to the EX700i and describes where to 
find information about these features.

NOTE: The following procedures use Windows XP illustrations, unless specified.

For more information See

Downloading files to the EX700i using the Docs WebTool  Utilities

Printing documents using E-mail Services “E-mail Service” on 
page 87

Printing documents using Hot Folders  Utilities

Printing documents using Command WorkStation  Utilities

Setting up the Windows environment for printing 
with Windows servers connected to the EX700i

 Configuration and Setup

Achieving optimal printing results from applications Color Printing and Fiery 
Color Reference

Setting print options and printing from Windows applications page 80

Specifying default print options page 83

Customizing the Quick Access icon page 84

Viewing the digital press status page 84

Saving files to print to a remote location page 84

Defining and printing custom page sizes page 129
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Setting print options and printing from Windows applications

To print from Windows platforms, install the PostScript printer driver. For instructions, see 
“Installing Windows printer drivers” on page 60. Be sure to configure the options on the 
Advanced tab of the printer driver after installation is complete, as described on page 64.

If you print to a virtual printer, you may not be able to set some print options, depending on 
how the virtual printer is configured.

Some print options that are selectable from an application are similar to print options that are 
specific to the EX700i and the digital press. In these cases, use the print options specific to the 
EX700i and the digital press. These options appear in the Fiery Printing tab. The application 
may not set up the file properly for printing on the EX700i, resulting in unexpected finishing, 
printing errors, or longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box 
provides instructions to resolve the conflict.

Some print options, such as expert color settings, are available only if Two-Way 
Communication is enabled or if a particular installable option has been configured. For 
information about enabling Two-Way Communication, see printer driver Help. For 
information about configuring installable options, see “Configuring installable options” on 
page 78.

If you choose Printer’s default, the job prints according to the settings that the administrator 
specified in Setup. For more information, see page 99.

The following procedures explain how to use the printer driver to specify print options for a 
particular job and print it to the EX700i. You can also set default print settings using the 
driver. For information about print options, see page 98.

NOTE: The following procedures use Windows XP illustrations.
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TO SET PRINT OPTIONS FOR A SPECIFIC WINDOWS PRINT JOB USING THE PRINTER DRIVER

1 In your application, choose File > Print, and select the EX700i as your printer.

2 Click Properties.

3 Click the Fiery Printing tab.

The Fiery Printing tab serves as the control center for all frequently used printing functions. 

For information about using presets, see printer driver Help.

NOTE: For a list of print options, see page 100.

1 Presets (Job Templates), 
see Help

2 Print Option icons
3 Customize (Shortcuts), 

see Help
4 Active area
5 Job View
6 Printer Status
7 Help

1

2

3

5

6

4

7
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4 Specify print options and settings for your job.

The print options are grouped by categories. Each group or tab contains print options that are 
similar or complement one another.

The groups or tabs are as follows:

Quick Access contains duplicate print options from the other job properties groups. It is 
customizable, so any Job Override print option can be added or removed from the view. The 
Quick Access tab lets you find print options quickly without having to browse through all the 
Properties tabs. For information about customizing the Quick Access view, see page 84.

Job Info contains all information about the job, including user information that may be 
required for user authentication, secure print properties, job handling, and document server. 
For information about Job Info options, see page 101.

Media contains attributes and sources of paper to print and insert. For information about 
Media options, see page 103.

Layout defines how the file is positioned or imaged on the media/sheet, except for positioning 
that compensates for finishing options, for example, Tray Alignment. For information about 
Layout options, see page 106.

Color contains color settings and graphic arts features (when enabled). For information about 
Color options, see page 111.

Image contains all Image Quality settings supported by the connected EX700i and digital 
press. For information about Image options, see page 116.

Finishing contains print options that are specific to the EX700i and to the finishing 
equipment on the digital press. These options override settings in EX700i Printer Setup but 
can be changed from Command WorkStation. For information about Finishing options, see 
page 117. 

VDP contains all Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP 
settings. For information about VDP options, see page 119.

Stamping contains any image stamping option that adds or hides/removes any image on the 
job. This also includes watermark properties that define the placement and style of the 
watermark. For information about Stamping/Watermark options, see page 120 or printer 
driver Help.

Printer - contains digital press status that includes the current paper and dry ink levels. For 
more information, see page 84 or printer driver Help.

5 After you specify the print settings, click Print to send your print job.
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Specifying default print options for print jobs

To set default print options, use the following procedure.

TO SET DEFAULT PRINT OPTIONS FOR WINDOWS PRINT JOBS USING THE POSTSCRIPT PRINTER DRIVER

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Vista/Server 2008: Click Start, choose Control Panel, and then double-click Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.

2 Right-click the EX700i icon and choose Printing Preferences.

3 If the Fiery Printing tab is not displayed, click it.

4 Specify the default settings for your print job, as described on page 81.

5 Click OK to close the dialog box.
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Customizing the Quick Access icon

The Quick Access view can be customized with the print options that you use frequently. This 
saves time because you do not have to open all of the other print option icons if you only want 
to set the options in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option 
icon. You can set the option from either location.

TO CUSTOMIZE QUICK ACCESS

1 In your application, choose File > Print, and select the EX700i as your printer.

2 Click Properties.

3 Click the Fiery Printing tab.

4 Click Customize to specify the options shown in the Customize Quick Access window.

You can select a shortcut from the Available Shortcuts list and add it to the Current Shortcuts 
list, as well as remove a shortcut from the Current Shortcuts list. Click OK to save your 
changes.

For more information about customizing the Quick Access icon, see printer driver Help.

Viewing the digital press status

If you enable a TCP/IP network, you can retrieve the digital press status and color settings 
from the EX700i and display them in the printer driver with the Two-Way Communication 
option. If you enable Two-Way Communication for your digital press, you can monitor the 
status of the digital press, including the levels of consumable materials, such as paper and dry 
ink.

For more information about enabling Two-Way Communication, see printer driver Help.

Saving files to print at a remote location

If you do not have an EX700i onsite and are preparing files for a service bureau or other 
location, print the final files to the File port (as opposed to one of the local ports). You can 
also print to the File port to create a file to download using the Docs WebTool. For 
instructions on printing to the File port, see the documentation that accompanies Windows.
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PRINTING METHODS

In addition to printing jobs from the EX700i printer driver, you can print jobs using these 
methods:

• Job Monitor displays information about the jobs sent to the EX700i and reprints them. 
For more information, see page 86.

• E-mail Service submits jobs to the EX700i as e-mail attachments. For more information, 
see page 87.

• USB device prints files saved on a USB drive. For more information, see page 90.

• FTP printing prints to the EX700i using the FTP protocol. For more information, see 
page 92.

• Secure printing requires that a password be entered at the EX700i before a job is printed. 
For more information, see page 93.

• Adobe PDF Print Engine (APPE) is an additional interpreter that allows native PDF 
processing and rendering without the need for the EX700i to convert the job from PDF to 
PostScript. For more information, see page 94.

• Direct Mobile Printing enables direct printing to the EX700i from mobile devices. For 
more information, see page 97.
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Configuring and using Job Monitor
Use Job Monitor to monitor the status of jobs sent to the EX700i and view information about 
them.

Job Monitor is supported only on Windows 32-bit version operating systems.

NOTE: Job Monitor is not supported on Windows 64-bit version operating systems, or 
Mac OS X.

Configuring the connection

When you send your first print job to the EX700i, Job Monitor opens and establishes a 
connection to the EX700i. If you installed and configured printer drivers for more than one 
digital press, Job Monitor automatically establishes connections to all the EX700i digital 
presses.

The Job Monitor icon ( ) appears on the desktop and in the Windows taskbar of 
your computer.

Job Monitor is automatically installed when you choose the printer driver to install on your 
computer. To use Job Monitor, you must enable it in the printer driver.

TO ENABLE JOB MONITOR

• Select the Monitor my Print Job check box on the Printer tab of the printer driver.

TO DISABLE JOB MONITOR

• Clear the Monitor my Print Job check box on the Printer tab of the printer driver.

Using Job Monitor

For information about using Job Monitor, see Job Monitor Help and printer driver Help. 
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E-mail Service
E-mail Service allows you to control the EX700i using your current e-mail infrastructure, 
print to remote locations, and bypass firewalls. E-mail Service is not application-specific. 
You can use any e-mail infrastructure.

NOTE: E-mail Service is not supported on Mac OS X.

The EX700i supports internal address books. Administrators can retrieve, add, delete, and 
clear addresses from the address books by sending requests through e-mail. For more 
information about address books, see Configuration and Setup.

To set up E-mail Service, see Configure Help.

Use E-mail Service in the following ways:

• Print a job from an e-mail application.

To print with an e-mail client, you send a file as an e-mail attachment. E-mail Service 
extracts the file and sends it to the EX700i. The attachment can be in any format the 
EX700i recognizes (PostScript, PDF, EPS, VDP, or TIFF).

NOTE: E-mail Service does not process files with .vbs, .exe, or .bat extensions.

• Manage jobs using an e-mail application.

You can manage your print jobs by submitting e-mail commands to the EX700i using 
e-mail.

• Scan to E-mail.

You can scan a document and send it to an e-mail address as an attachment or URL. 
For more information about Scan to E-mail, see Utilities.

Printing using an e-mail client

You can submit print jobs to the EX700i in the form of an e-mail attachment using your 
e-mail application. When you send an e-mail with an attachment, E-mail Service extracts the 
file and sends it to the EX700i Print queue. The file format must be one supported by the 
EX700i. 

By default, anyone can print with an e-mail client, unless the Print address book has been set 
up by the administrator. If the Print address book has been set up and your e-mail address is 
not in it, you cannot send files to the EX700i via e-mail. For more information about address 
books, see Configuration and Setup. 
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When User Authentication is enabled on the EX700i, the e-mail attachment must have the 
appropriate user name and password when it is printed through e-mail printing. As part of 
creating the e-mail attachment with the EX700i printer driver, type the appropriate user name 
and password in the Job Info tab of the printer driver. The user name and password must 
match those defined by the administrator in the Users and Groups section of Configure. For 
information about Users and Groups, see Configure Help.

NOTE: The Direct connection is not supported by the e-mail client feature.

NOTE: The following illustrations depict the Microsoft Outlook e-mail application. 

TO PRINT USING AN E-MAIL CLIENT

1 Open your e-mail application.

2 Type the EX700i e-mail address in the To: line.

3 Type text in the Subject line or leave the Subject line blank.

4 Attach the file that you want to print. 

The attachment can be in any format the EX700i recognizes (PostScript, PDF, EPS, VDP, 
or TIFF).

NOTE: If your attachment exceeds the file size limitation set by your e-mail system 
administrator, the e-mail is not sent. 

5 Optionally, you can type text in the body of the message. The text is printed with the file.

NOTE: HTML-formatted e-mail messages are not supported, and might not print as they 
appear on the remote workstation. Send e-mail messages in plain text format.

6 Send the e-mail.
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The file is sent to the EX700i and the job is printed. After the EX700i receives the job, you 
are sent an e-mail notification that the print job was accepted. The e-mail provides a job 
identification (ID). Use the job IDs to manage jobs with e-mail commands (see “Managing 
print jobs with e-mail commands” on page 89). The e-mail notification indicates any current 
error at the digital press. 

After the job is printed, you are sent a second e-mail notification that indicates the job printed 
successfully. 

Managing print jobs with e-mail commands

You can manage your print jobs by submitting commands to the EX700i using e-mail. You 
can cancel a job, check job status, and get help on a job. When you send a command, the 
EX700i returns an e-mail response. 

TO MANAGE PRINT JOBS WITH E-MAIL COMMANDS

1 In your e-mail application, type the EX700i e-mail address in the To: line.

2 Type one of the following commands in the Subject line:

To check the status of a job, type #JobStatus<job id> in the Subject line.

You receive a reply to your job status query. You can only get the status of the job if you sent 
the job or are an administrator.

To cancel a job, type #CancelJob<job id> in the Subject line. 

You receive a notification indicating that the job has been cancelled and did not print to the 
EX700i. You can only cancel a job if you sent the job.

To get help, type #Help in the Subject line.

You receive an e-mail response that contains links that allow you to cancel jobs, check job 
status, and search and manage address books. Click any of the links to perform a command.

3 Send the e-mail to the EX700i.
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Printing from a USB device
You can print files on a USB device to the EX700i. To do so, save PS, PCL, EPS, TIFF, and 
PDF files to the USB device and download them directly to the EX700i. You can print files 
that originated on Mac OS X or Windows computers.

You can print files automatically from a USB device to one of the standard print queues on 
the EX700i (Print, Hold, or Direct) or to published virtual printers (if supported). Verify 
with your administrator that these connections are published in Setup. Or you can print any 
of the files on your USB device, specify where to send them, and also select some print 
options. For more information about virtual printers, see Command WorkStation Help.

Before you print files from a USB device, ask your administrator to configure the appropriate 
options. For more information about configuring the appropriate options, see Configuration 
and Setup or Configure Help.

The two methods of printing files from a USB device are automatic printing and manual 
printing.

Automatic printing

To print automatically to Print, Hold, or Direct queues, or to published virtual printers with 
the Print All setting, set up folders on your USB device with the names print, hold, direct, 
and the names of any published virtual printers. When you plug the USB device into a USB 
port on the EX700i, the files in those folders are sent automatically to the corresponding 
queues. 

TO PRINT FILES FROM THE USB DEVICE

1 Configure the USB printing options in Setup.

2 Create folders at the top (root) level of the USB device named print, hold, direct, and virtual 
printer.

3 Save the files (PS, EPS, PCL, TIFF, and PDF) from the user’s computer to the USB device. 

Files copied to the print, hold, direct, or virtual printer folders are downloaded to the 
corresponding print connection on the EX700i automatically when you connect the USB 
device to the EX700i. Files copied to the root level of the USB device are downloaded to the 
Print queue.

4 Remove the USB device from the computer and connect it to the USB connector on the 
EX700i. 

Make sure that the USB device is properly stopped before you disconnect it from the 
computer.

For the location of the USB port, see Configuration and Setup. 
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Manual printing

When USB Media Autoprint is disabled in Server Setup, you must manually select the files 
you want to print from the USB device and specify where you want to send them.

NOTE: Integrated Fiery Color Server does not support manual printing from the USB device.

TO PRINT USING USB MEDIA SERVER

1 Insert the USB device into a USB port on the EX700i.

2 Press All Services icon on the digital press touch panel.

3 Press Web Applications.

4 Press the USB tab to view the USB Media Server browsing window.

The queues (Print, Hold or Direct) are displayed. The queues displayed correspond to the 
folders that you created on the USB device.

The files on the USB device are displayed on the digital press touch panel. Both files at the 
root level of the USB device and folders are displayed.

5 Press Browse next to a folder to open it.

6 To browse back to the root level, press Upper Directory located in the lower-left corner.

7 To navigate through the list of files and folders, you can press First, Prev, Next, Last.

8 Print one file or all files in the directory.

• To print one file, select it, press Print, and proceed to step 9.

• To print all files in the directory, press Print All located in the lower-left corner.

9 Specify print options for the file.

The print options you can choose are:

• Queue (Print, Direct, Hold or any published virtual printer set up for the EX700i)

• Copies (number of copies)

• Duplex (Default, Off, Top-Top, Top-Bottom)

• Page Size (Default, list of page sizes

10 Press Print to send the file to the EX700i Print Server for printing or Cancel to cancel the 
print request.

11 Press All Services on the digital press touch panel.

12 Remove the USB device from the EX700i.
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FTP printing
If FTP Services are enabled on the EX700i, the EX700i is set up as an FTP server. You can 
send jobs to the EX700i using FTP printing. For more information about configuring FTP 
Services, see Configure Help.

You can use any FTP client software. Before you use FTP printing, the FTP client software 
requires the following information (see your administrator):

• IP address or DNS name for the EX700i

• Directory or path to send the job to, such as the Print queue, Hold queue, or published 
virtual printers (if supported)

NOTE: You cannot print to the Direct connection using FTP printing.

• User name and password (if required)

You can send PostScript (PS), Printer Control Language (PCL), Tagged Image File Format 
(TIFF), and Portable Document Format (PDF) files to the EX700i. Encapsulated PostScript 
(EPS) files are not supported for FTP printing.

TO PRINT FILES TO THE EX700I USING THE FTP PROTOCOL

1 Connect to the EX700i with your FTP client software.

Folders corresponding to the Print queue and Hold queue are displayed. Folders for any 
published virtual printer are also displayed.

2 Navigate to the folder representing the print connection or published virtual printer.

3 Upload your job to the folder that you want.

After the job is printed, it is deleted from the EX700i.
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Printing and retrieving a secure print job
The Secure Print feature offers a level of security for confidential or sensitive print jobs, which 
print only when you are present at the digital press. To use this feature, you first enter an 
arbitrary password into the Secure Print field in the printer driver when you send your job to 
the EX700i. To print your job, you re-enter the password at the EX700i digital press touch 
panel as described in the following procedures.

TO SEND A SECURE PRINT JOB

1 In your application, choose File > Print.

2 Select the EX700i as the printer.

3 Windows: Click Properties, and then click the Job Info icon.

Mac OS X: Choose Fiery Features from the drop-down list, click Full Properties, and then click 
the Job Info icon in the Printing Preferences dialog box.

4 Type an arbitrary password in the Secure Print field. 

NOTE: The password is limited to alphanumeric characters (do not use symbols).

For more information about typing the password, see page 102.

5 Make any other required changes to Job Properties and send your job to the EX700i.

6 Click OK to close the EX700i Properties dialog box.

7 Click OK or Print to close the Print dialog box.

The job is sent to the digital press.

TO RETRIEVE A SECURE PRINT JOB

1 At the digital press touch panel, press the Fiery button.

2 Press the Jobs tab.

3 Press the Secure Print tab.

4 At the Password screen, click the Password field, and a keyboard appears.

5 Type the same password that you typed in the Secure Print field of the printer driver, and 
then press OK.

The print jobs that match the password are displayed in the login window.

6 Select your print job and choose Print or Delete.

After 45 seconds of inactivity, the Secure screen returns to the main Jobs screen.
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Adobe PDF Print Engine (APPE)
The EX700i provides features of the Adobe PDF Print Engine (APPE), which is an additional 
interpreter that allows native PDF processing and rendering without the need for the EX700i 
to convert the job from PDF to PostScript.   No special printer driver is required for printing 
APPE jobs, but the administrator must enable related settings in Setup. If APPE is not 
enabled, PDF files are processed with the PostScript interpreter of the EX700i. All PostScript 
files continue to be processed with the PostScript interpreter.

The APPE option is not available from the printer driver, but is included in Job Properties in 
Command WorkStation. After the administrator enables APPE as the default in Configure, 
you can enable or disable the APPE option in Job Properties on a per-job basis.

To enable Adobe PDF Print Engine (APPE) workflow in the EX700i, see Configuration and 
Setup. 

NOTE: Integrated Fiery Color Server does not support APPE.

Printing with APPE workflow

You can print with the APPE workflow using one of the following methods:

• Command WorkStation

Import a job, or drag a job from your computer and drop it in the Job Center of 
Command WorkStation.

For information about using Command WorkStation, see Command WorkStation Help.

• Hot Folders

Configure a hot folder for APPE. 

For information about using Hot Folders, see Hot Folders Help.
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USING APPE WORKFLOW IN COMMAND WORKSTATION

1 Double-click a PDF job in the Held or Printed list, or select the job and do one of the 
following:

• Right-click to select Properties.

• Choose Job Center > Properties.

• Choose Properties from the Actions menu.

For information about printing multiple files, see “Printing multiple files with APPE” on 
page 96.

2 Select the Adobe PDF Print Engine Preferred check box.

3 Specify the print option settings, and then click Print.

1 Adobe PDF Print Engine 
Preferred option

1
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Printing multiple files with APPE
If you open Job Properties for files of different file types, the Adobe PDF Print Engine 
Preferred option is displayed only if one of the selected files is a PDF. The print option name 
is shown as Adobe PDF Print Engine Preferred (Applies only to PDF jobs) and the check box 
indicates at least one of the PDF jobs selected has been processed through the APPE 
workflow.

For a multiple file selection containing non-PDF files, the Adobe PDF Print Engine Preferred 
option is not shown.

If a PDF file contains mixed page sizes when processed using APPE, the Paper Size option 
reflects the size of the first page in the PDF. If you override the size in Job Properties, all of 
the pages in the PDF become the selected size.

TO ACCESS THE PROPERTIES OF MULTIPLE JOBS

1 Shift-click to select multiple, sequential jobs, or Ctrl-click to select multiple, non-sequential 
jobs, and then click Properties.

The Job Properties dialog box appears. Menus for each available print option are displayed.

2 After the multiple jobs have opened, specifying a value in the Job Properties dialog box 
applies it to all jobs.

The Summary tab allows a side-by-side comparison of the Job Properties for multiple jobs.

1 Adobe PDF Print Engine 
Preferred (Applies only
to PDF jobs) option

1
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Direct Mobile Printing
Direct Mobile Printing enables direct printing to the EX700i from mobile devices, such as 
iPad, iPhone, and iPod touch. The EX700i must have certain networking options enabled in 
Setup. After Setup is complete, the EX700i appears in the list of available printers on the 
mobile device.

In addition, observe the following configuration requirements:

• Make sure that the EX700i is connected to a wireless access point on the network.

• Make sure that supported mobile devices are connected to the same wireless network as 
the EX700i. The Printer Default Paper Size is used for all Direct Mobile Printing jobs.

For information about configuring the settings in Setup on the EX700i, see Configuration and 
Setup.

For a list of supported mobile devices, see Welcome.

TO PRINT FROM A MOBILE DEVICE

1 On the mobile device, open the Print window.

For more information, see the documentation that accompanies your device.

2 Select the EX700i printer in the list of available printers.

3 Specify print settings, and then click Print.
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PRINT OPTIONS

This chapter describes printer drivers and PPD (PostScript Printer Description) files, EX700i 
print options, and where to set print options.

About printer drivers and printer description files
The EX700i receives files from computers on the network, processes (RIPs) the files, and then 
sends them to the digital press. Windows and Mac OS computers communicate with the 
EX700i by means of a printer driver and a PostScript Printer Description (PPD) file. A PPD 
file contains information about the features and capabilities of a particular device (for 
example, what paper sizes and media types are supported). The PPD file for the EX700i 
includes information about the features of both the digital press and the EX700i.

A printer driver manages printing communication between your application and the printer. 
It interprets the instructions generated by the application, merges those instructions with 
printer-specific options you set, and then translates all information into Adobe PostScript, 
a language the printer understands. In other words, the printer driver writes a PostScript file 
based on your original file and the options you set from the Print dialog box.

For information about the specific print options for the EX700i, see the tables that begin on 
page 101.
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Setting print options
Print options give you access to the special features of your digital press and the EX700i. You 
can specify print options in these areas:

• Setup

Some settings are specified during Setup by the administrator. For information about the 
current default server settings, contact the administrator or the operator.

• Applications

With the printer drivers provided, you can specify job settings when you print a job.

For more information, see “Defining and printing custom page sizes” on page 129. 

• Color Setup

Set the default CMYK/Grayscale Source, CMYK/Grayscale Processing Method, RGB 
Source, Separate RGB/Lab to CMYK Source, Output Profile, RGB/Lab Rendering Intent, 
Spot Color Matching, Gray (CMYK), Gray (RGB), Black Text and Graphics, and Black 
Overprint settings. 

For information about using Color Setup, see Color Printing.

• Hot Folders

Assign a group of print options to a Hot Folder. When you specify print options for a 
Hot Folder, the print options are assigned to all jobs sent through that Hot Folder. 
These print options override any default options. 

For information, see Hot Folders Help.

• Overrides in Command WorkStation Job Properties

To change job settings from Command WorkStation, double-click a job to display the 
Properties dialog box. 

For more information, see Command WorkStation Help.

Print option override hierarchy

The override hierarchy is as follows: 

• Settings from the user’s printer driver override the EX700i Setup settings.

• Settings assigned to Hot Folders override the user’s printer driver settings.

• Settings made from the job management tools (Command WorkStation Job Properties) 
override the user’s printer driver settings.
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Print options and default settings
If you do not use the printer driver interface to configure a particular option, the EX700i 
prints the job with the default setting. For options that the administer configures, choosing 
Printer’s default results in the EX700i printing the job with the factory default. For options 
that cannot be configured in Setup, the EX700i prints the job with a preconfigured Printer’s 
default setting. When you select the printer driver for US, the default Document Size is Letter 
or for International, the default Document Size is A4. For more information, see the 
following tables.

To determine the current Setup defaults, print the Configuration page from Command 
WorkStation. For information about how to print a Configuration page, see Configuration 
and Setup.

NOTE: A job uses the EX700i default settings (unless otherwise specified) at the time it is 
processed for printing, and not at the time it is sent to the EX700i Hold queue.

The print option tables are organized according to the printer driver icons (tabs). Use the 
following links for quick access:

Printer driver icon See

Quick Access (shortcuts) page 33, page 59 or 
page 84

Job Info page 101

Media page 103

Layout page 106

Color page 111

Image page 116

Finishing page 117

Variable Data Printing (VDP) page 119

Stamping/Watermark page 120
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Job Info options

Option Information

Copies The maximum number of copies is 9999.

Print Range Specify the page range or odd/even pages to print.

For VDP jobs, a range of Records can be selected for printing. For imposed VDP jobs, a range of 
Records & Sheets can be printed.

For imposed jobs, a range of Sheet IDs can be selected for printing.

This option is only accessible from Command WorkStation Job Properties.

Destination Specify the location to output the print job.

File Name Specify the file name for your job when you use Mail Box or Form Store. 

Schedule Printing Specify to perform advance print scheduling based on date and time. If you select On, select the 
date and time for the print job.

The job is printed based on the date and time set on the EX700i, not the client workstation.

If multiple jobs are selected and defined with the same date and time setting, job order is based on 
alphabetic order of the file names.

This option is not available for the Integrated Fiery Color Server.

User Authentication: User Name If User Authentication is enabled on the EX700i, specify your User Name to print a job. Type your 
user name or domain\user name for user authentication.

User Authentication: Password If User Authentication is enabled on the EX700i, specify your User Password to print a job. Type your 
local password or domain password for user authentication.

User Authentication: Use 
Windows Login 

If you are logged on to your Windows computer, select Use Windows Login for user authentication.

This option appears when you log on to your domain on your Windows computer. 

For more information, see Configuration and Setup.

User Authentication: I’m a Guest Select On to allow guest printing. Guest printing must be set to On at the EX700i.

In Command WorkStation, the management of jobs is determined by how you log on to the EX700i.
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Print Queue Action Select the job action associated with a published queue.

Select Print to send the file directly to printing.

Select Print and Hold to save the raster file after printing.

Select Hold to spool the job until the operator takes further action. Held jobs can exist in a 
preprocessed or processed state.

Select Process and Hold to RIP (process), but not print a job.

Select Print and Delete to queue the job to process, print, and then delete it. This action ensures the 
printed job is not saved to the Printed list, which is often required for secure printing.

Select Proof Print to print a single copy of a job(s) to verify output. This action is only accessible from 
Command WorkStation Job Properties.

This option is invalid if your job is sent to the Direct connection.

Notes 1/Notes 2 Specify information about the job. This field has a 31-character (alphanumeric and special characters) 
limit.

Instructions Specify instructions for the operator about the job. This field has a 127-character (alphanumeric and 
special characters) limit. 

Secure Print Use when printing sensitive or confidential documents. 

Specify an arbitrary password and re-enter it when you are present at the digital press.

For information, see the documentation that accompanies your digital press.

Control Bar Specify On to print a Control Bar (for print job identification) in the margin.

This option is available as part of the Fiery Graphic Arts Package, Premium Edition for the EX700i 
Print Server and the Fiery Productivity Package for Integrated Fiery Color Server. For more 
information, see Fiery Graphic Arts Package. 

Printer’s default reflects the setting specified in Color Setup in Command WorkStation.

Progressives Specify On to enable the Progressives feature, a diagnostic tool used to show dry ink separations.

This feature uses the Progressives values specified in Color Setup in Command WorkStation.

This option is available as part of the Fiery Graphic Arts Package, Premium Edition. For more 
information, see Fiery Graphic Arts Package.

This option is not available for the Integrated Fiery Color Server.

NOTE: The Progressives and Postflight features cannot be used at the same time,

Postflight Specify whether or not you want to use the Postflight feature, a diagnostic tool that allows you to 
analyze how data is processed by the EX700i.

This option is available as part of the Fiery Graphic Arts Package, Premium Edition for EX700i Print 
Server and the Fiery Productivity Package for Integrated Fiery Color Server. For more information, see 
Fiery Graphic Arts Package.

NOTE: The Progressives and Postflight features cannot be used at the same time,

Option Information
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Media options

Option Information

Paper Catalog Click Select to access the Paper Catalog utility, which retrieves all paper information from the digital 
press.

For information about accessing Paper Catalog, see Utilities. For information about using Paper 
Catalog, see Command WorkStation Help.

Access to Paper Catalog requires Two-Way Communication. For information about establishing 
Two-Way Communication, see printer driver Help.

Paper Source Specify the paper source that contains the paper to use for your print job.

To use Tray 6, Tray 6 (Oversized), Tray 7 (Oversized), and Tray 8 (Inserter), these option must first be 
installed.

For information about setting your choice of media in one of the trays, see the documentation that 
accompanies your digital press.

Paper Size Paper Size defines the size of the sheet of paper on which your job prints. It is the size of the physical 
sheet of paper in the digital press tray. To assign Paper Size, do one of the following:

• Select the size from the available list. (SEF stands for Short Edge Feed; LEF stands for Long Edge 
Feed.)

• Click Custom to select a non-standard paper size.

• Select Same As Document Size to print one document page per sheet of paper.

The default size is Letter in the U.S. and A4 elsewhere. For more information, see page 130. 

Media Type Choose the media type for your print job. 

For information about media types and paper specifications, see the documentation that accompanies 
the digital press.

Media Weight Select the weight for media used for your print job. Select Use Machine Settings to use the media that 
is set on the digital press.

Media Color Specify the media when printing on colored paper.

Tray Alignment Specify On to adjust the image on the page to achieve alignment on both sides of a page when printing 
duplex.

For information about using Tray alignment, see Command WorkStation Help.



PRINT OPTIONS 104

Document Size Document Size is the page size defined in your application’s Print setup (or Page setup) dialog box. 

In cases when printing one document page per sheet of paper, Document Size is usually the same as 
Paper Size. However, it may differ when printing booklets or imposing multiple document pages on a 
single sheet. 

Document Size may also differ from Paper Size when you use the Scale or Scale to Fit options, in 
which case the document page size is scaled at a given percent to fit a certain paper size.

To assign Document Size, do one of the following:

• Select the size from the available list. (SEF stands for Short Edge Feed; LEF stands for Long Edge 
Feed.)

• Click Custom to select a non-standard paper size.

NOTE: The default is Letter in the U.S. and A4 elsewhere.

For more information about Document size and Paper size, see page 130.

For information about Scale and Scale to fit, see page 136.

For information about printing custom page sizes, see page 129.

Use Set Page Device Media 
Mapping

Set Page Device (SPD) commands are instructions within PostScript, VIPP, and VPS files that specify 
certain attributes of a print job. You can enable SPD Media Mapping in EX700i Setup. For 
information about enabling in Setup, see Configuration and Setup. 

Select On to allow the EX700i to recognize and apply certain attributes of a print job on a job-level 
basis, including: 

• Paper attributes (for example, Media Type and Media Color) 

• Finishing attributes (for example, stapling or folding) 

• Generic attributes (for example, simplex or duplex, number of copies)

This option is only accessible from Command WorkStation Job Properties.

For more information, see Configure Help.

Slip Sheet Specify whether to insert a slip sheet between copies or pages of multiple-copy jobs. 

This option is effective only for non-sorted or collated jobs.

Slip Sheet Page Size Specify the slip sheet page size by selecting from the list of available sizes. (SEF stands for Short Edge 
Feed; LEF stands for Long Edge Feed.)

Slip Sheet Paper Source Specify the paper tray to use for the slip sheet.

To use Tray 6, Tray 6 (Oversized), Tray 7 (Oversized), and Tray 8 (Inserter), these option must first be 
installed.

For information about installing optional trays, see page 27, page 53, or page 78.

Slip Sheet Offset Specify On to print the slip sheets offset from the pages in the job.

Transparency Interleaving Select On to print multiple transparency sheets separated by blank, plain paper pages.

Option Information
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Transparency Interleave Paper 
Source

Select a paper source tray for transparency interleaving.

To use Tray 6, Tray 6 (Oversized), Tray 7 (Oversized), and Tray 8 (Inserter), these option must first be 
installed.

For information about installing optional trays, see page 27, page 53 or page 78.

Mixed Media Specify different media types, paper source, and chapter-based finishing for pages, or ranges of pages, 
within a print job. 

For more information, see printer driver Help. 

For information about accessing and using Mixed Media in Command WorkStation, see Command 
WorkStation Help. Features specific to the EX700i are described in Utilities.

Option Information
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Layout options

The driver has the following layout modes:

• Normal: use these options for printing standard documents, from 1 to 16 document pages 
per sheet (page 106).

• Gangup: use these options for speed printing imposition modes (page 107). For additional 
information, see page 133.

• Booklet: use these options for printing documents in booklet layout (page 108). 
For additional information, see page 122.

• Impose: use imposition layouts for custom printing, binding, and trimming (page 110).

Normal

Option Information

Duplex Select Off for single-sided printing.

Specify Top-Top or Top-Bottom for duplex (double-sided) printing by specifying the orientation of 
printed images.

For more information, see page 131.

Rotate 180 (check box) Specify On to rotate the pages of a job 180 degrees.

Scale Specify an increase or decrease in the scale of your print job. When using the manual Scale option, you 
cannot specify Scale to Fit.

For more information, see page 136.

Scale to Fit Specify whether to scale your job to fit to a paper size. When using the Scale to Fit option, you cannot 
use the manual Scale option.

For more information, see page 136.

Manual Duplex (check box) Specify On to manually duplex the pages of a job.

Orientation Specify Portrait or Landscape page orientation for the document.

This option is not available from the Mac OS X printer driver and Command WorkStation Job 
Properties.

Mirror Select On to print the mirror image of the job.

This option is not available from the Mac OS X printer driver and Command WorkStation Job 
Properties.

Print Border Select On to print borders around each page in your print job.

Pages per Sheet Specify the number of document pages per sheet of paper for your print job.

NOTE: This option is invalid if your job is sent to the Direct connection.

Page Order Specify the layout direction when the Pages per sheet option is set to 2-up or greater.
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Gangup options

Option Information

Gangup Select On to specify options for speed printing imposition modes.

Gang-up type Select Step & repeat to speed print a job by printing two document pages on each sheet. When the 
printed sheets are cut in half, the result is two complete sets of the same document.

Select Cut & stack to speed print a job by printing two document pages side by side. When the printed 
sheets are cut in half and stacked together, the result is one complete set of the document (in faster 
printing time).

For more information, see page 133.

Paper Size Sefines the size of the sheet of paper on which your job prints. It is the size of the physical sheet of 
paper in the digital press tray. To assign Paper Size, do one of the following:

• Select the size from the available list. (SEF stands for Short Edge Feed; LEF stands for Long Edge 
Feed.)

• Choose Select From Paper Catalog to access a dynamic database that stores the media attributes of 
any paper available for printing from the EX700i.

• Select Custom Paper Size to select a non-standard paper size.

• Select Same As Document Size to print one document page per sheet of paper.

The default size is Letter in the U.S. and A4 elsewhere.

For information about Paper size and Document size, see page 130.

For information about printing custom page sizes, see page 129. 

For information about accessing Paper Catalog, see Utilities. For information about using Paper 
Catalog, see Command WorkStation Help.

Shrink to fit Automatically scales down or reduces the document page size to fit the imageable area of the selected 
paper size specified from the Paper size menu. Shrink to fit does not scale up or enlarge.

When Shrink to fit is set to Off, page contents print at 100%.

Increase gutter by 
0/-50.0–50.0 mm 
(0.1 mm increments)
0/-1.969–1.969 in 
(.001 inch increments)

Controls the amount of space between adjacent pages on a sheet to adjust for trimming or other 
finishing options. 

Specify a positive value to increase the amount of blank space between adjacent pages.

Specify a negative value to decrease the amount of blank space between adjacent pages.

Duplex Select Off for single-sided printing.

Specify Top-Top for duplex (double-sided) printing to specify the orientation of printed images.

For more information, see page 131.
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Booklet options from the printer driver

This table references the Booklet Maker print options accessible from the printer driver. For 
the Booklet Maker print options accessible from Command WorkStation Job Properties, see 
“Booklet Maker in Job Properties” on page 124.

NOTE: You can use the Booklet Maker Wizard to specify your booklet options by clicking 
Launch Wizard.

Option Information

Booklet Select On to specify options for printing documents in booklet layout. Click Launch Wizard to specify 
how to arrange the pages of the job in special layouts for folding or cutting after printing.

Booklet Type Booklet Type is a combination of binding method, which determines how the signatures of the 
booklet are folded and imposed, and binding edge, which determines the location of the spine of the 
booklet.

For more information, see Booklet Maker Help.

Paper size: Paper Size for 2-up Defines the size of the sheet of paper (unfolded) on which a booklet is printed. 

To select a Paper size for a booklet, do one of the following:

• Select from the list of available sizes. (SEF stands for Short Edge Feed; LEF stands for Long Edge 
Feed.)

• Choose Select From Paper Catalog to access a dynamic database that stores the media attributes of 
any paper available for printing from the EX700i.

• Select Custom Paper Size to create a non-standard Paper size.

• Select Same As Document Size to print one document page per sheet of paper.

The default Paper Size is Letter in the U.S. and A4 elsewhere.

For information about Paper size and Document size in booklets, see page 130 and Booklet Maker 
Help.

For information about accessing Paper Catalog, see Utilities. For information about using Paper 
Catalog, see Command WorkStation Help.

For information about printing custom page sizes, see page 129.

Paper size: Shrink to fit Automatically scales down or reduces the document page size to fit the imageable area of the selected 
paper size specified from the Paper size menu. Shrink to fit does not scale up or enlarge.

When Shrink to fit is set to Off, page content prints at 100%.

For more information, see Booklet Maker Help. 

Subset Size: Number of sheets
in a subset (Saddle)

When Nested Saddle is selected, use this option to specify the number of sheets in each subset.

This option appears only when Nested Saddle is selected.
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Page alignment: 
Centering Adjustment

Align pages positions page content in relation to the center of one-half the paper size or the spine, the 
center of the sheet where the fold occurs.

At the center positions page content in the center of one-half the specified paper size.

At the spine aligns page content with the spine or center fold of your booklet.

For more information, see Booklet Maker Help.

Page alignment: 
Increase gutter by
0/-50.0–50.0 mm 
(0.1 mm increments)
0/-1.969–1.969 in 
(.001 inch increments)

Increase gutter by controls the amount of space between adjacent pages to adjust for binding or other 
finishing options. 

Specify a positive value to increase the amount of blank space between adjacent pages.

Specify a negative value to decrease the amount of blank space between adjacent pages.

For more information, see Booklet Maker Help.

Page alignment: 
Compensate creep 

Compensate creep for adjusts the position of the page content to counteract the shift that occurs when 
sheets are folded to create Saddle and Nested Saddle booklets.

Select Plain when printing Saddle or Nested Saddle booklets with a large number of pages.

Select Thick when printing Saddle or Nested Saddle booklets on heavyweight paper.

For more information, see Booklet Maker Help.

Cover: Content input Select Front & Back Separately to include cover content (individual pages in your document) as part of 
your booklet print job.

Select Pre-Printed (use insert) to insert a pre-printed cover that will be added to the body pages from 
an inserter tray.

For more information, see Booklet Maker Help.

Cover: Front Cover When Front & Back Separately is selected, use the Front Cover option to define how the content of 
the front cover is printed.

Select Print on outside to print only on the outside of the front cover (the inside of the front cover will 
be blank).

Select Print on inside to print only on the inside of the front cover (the outside of the front cover will 
be blank).

Select Print on both sides to print on both the inside and outside of the front cover.

Select Do not print if you do not want any content printed on the front cover.

When you add a cover, blank pages may be inserted depending on the allocation of pages to signatures. 
For more information, see Booklet Maker Help.

Option Information
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Impose options

The Impose option is only accessible from Command WorkStation Job Properties.

Cover: Back Cover When Front & Back Separately is selected, use the Back Cover option to define how the content of the 
back cover is printed.

Select Print on outside to print only on the outside of the back cover (the inside of the back cover will 
be blank).

Select Print on inside to print only on the inside of the back cover (the outside of the back cover will be 
blank).

Select Print on both sides to print on both the inside and outside of the back cover.

Select Do not print if you do not want any content printed on the back cover.

When you add a cover, blank pages may be inserted depending on the allocation of pages to signatures 
in the job. For more information, see Booklet Maker Help.

Cover: Define Cover Click Define Cover to specify the following cover options: Cover Source (Saddle only), Media, Media 
Type, and Media Weight.

Option Information

Option Information

Impose Select On to specify an imposition layout for a job.

Templates Specify an imposition layout template for a job.

The available templates are as follows:

• Normal - Default Template and 1-up full bleed

• Booklet - 2-up perfect, 2-up saddle, and 4-up head to head

• Gangup - 3-up trifold brochure, 4-up gate fold, and 4-up z fold

Edit Impose Template Click Edit Impose Template to open a template in Fiery SeeQuence Impose for editing.

For information about Impose, see Utilities. For information about using Impose, see Command 
WorkStation Help.
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Color options
.

Option Information

Color Mode Specify the color mode for the current print job.

Select CMYK for a full-color document.

Select Grayscale for a grayscale or black-and-white document.

Choose Basic Settings to specify color print options and settings. 

Choose Expert Settings to edit other color print options and settings, including Black Overprint, Black 
Text and Graphics, Gray (CMYK), and Gray (RGB). 

For information about Expert Settings, see page 113.

Auto Trapping Specify whether the job should automatically reduce white gaps for text and graphics.

Setting this option to On may result in graphics or text surrounded with borders.

For more information, see page 122.

Black Detection When printing jobs with both black-and-white and color pages, use this option to detect black-and-
white pages before the job prints.

Select Off if the job contains a significant number of color pages.

Select On if the job is predominantly black and white.

For more information, see Color Printing.

Composite overprint Select On to overprint objects that are specified in the source PostScript or PDF file.

Design applications are typically set to knock out objects. To overprint, you must first change the 
settings in the source application. When the Composite Overprint option is then set to On, the 
overprinting commands specified in the source application take place, provided the output is 
composite and consistent with the separations output.

For more information, see Color Printing.

Combine separations When printing separations from supported desktop publishing applications:

Select On to combine separations on a single page. 

Select Off to view separations as four individual black-and-white pages, each representing one color 
plate.

For more information, see Color Printing.

Substitute Colors Select On to use the Substitute Color Values defined in the Spot-On module. 

For more information, see Color Printing.
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2-Color print mapping Select On if you want to replace spot colors with generic colors when you are creating a print job. 

This option is available as part of the Fiery Graphic Arts Package, Premium Edition.

This option is not available for the Integrated Fiery Color Server.

For more information, see Fiery Graphic Arts Package.

Optimize RGB Transparency Enable this option to achieve correct color output for areas of overlapping transparent RGB or Lab 
colors (such as a drop shadow) in a PDF job. This option has no effect if the Adobe PDF Print Engine 
Preferred option is enabled.

This option is only accessible from Command WorkStation Job Properties, Hot Folders, and Virtual 
Printers.

For more information, see Color Printing.

Option Information
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Expert Settings options

To access the following options, click Expert Settings.

Expert Settings has the following modes:

• Color Input: use these options for color printing (page 113).

• Gray & Black Processing: use these options for grayscale or black-and-white printing 
(page 115).

• Output: specify the output profile to use for printing document (page 115). 

Color Input

Option Information

CMYK/Grayscale Source Specify the simulation profile to be used for the current print job. 

For more information, see Color Printing.

Use embedded profile when 
present (CMYK)

When this option is enabled, the EX700i  ignores the CMYK/Grayscale Source option and uses the 
CMYK profile embedded in the print job as the CMYK source profile. 

CMYK/Grayscale Processing 
Method 

Specify the simulation method for CMYK print jobs. 

Select Full (Source GCR) for a more complete and accurate simulation. Full (Source GCR) applies 
colorimetric transformations that adjust hue as well as output density and produces output that 
maintains the same amount of black as the source document. 

Select Full (Output GCR) to apply the same simulation method as Full (Source GCR), except that the 
output produced contains a black amount determined by the Output Profile.

Select Pure Primaries to use one-dimensional transfer curves to adjust density output of individual 
color channels.

For more information, see Color Printing.

Paper Simulation Specify to adjust the color according to the shade of the paper stock used as printable CMYK values in 
the output color space. 

This option is available as part of the Fiery Graphic Arts Package. 

For more information, see Color Printing. 

RGB Source Specify a source color space definition for printing RGB images, objects, and text. 

For more information, see Color Printing.

Use embedded profile when 
present (RGB)

When this option is enabled, the EX700i ignores the RGB Source option and uses the RGB profile 
embedded in the print job as the RGB source profile. 
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RGB/Lab Rendering Intent Specify a default CRD (color rendering dictionary) for color conversion when printing RGB images, 
objects, and text.

Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, 
with well-rendered flesh tones and more saturated colors.

Select Photographic to print photographs, including scanned and digital camera images. The result is 
less saturated than Presentation style.

Select Relative Colorimetric when color matching is important, but you also want to print white as 
paper white. The white point transformation eliminates borders between blank spaces and white 
objects.

Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. 
There is no white point transformation.

For more information, see Color Printing.

Separate RGB/Lab to CMYK 
Source 

Select for RGB jobs when you want to simulate an output device other than the device to which you 
are printing.

For more information, see Color Printing.

Spot Color Matching Select Off to print specified PANTONE colors in your job using the current CMYK/Grayscale Source 
and CMYK/Grayscale Processing Method.

Select On to activate the PANTONE Lookup Table. The EX700i prints specified PANTONE colors 
in your job by matching the CMYK print blend to the same color from the PANTONE library.

For more information, see Color Printing.

PDF/X Output Intent Specify On to enable the PDF/X Output Intent feature to use the embedded output intent for PDF/X 
compliant print jobs.

To use PDF/X Output Intent, you must enable the Use Embedded Profile When Present (RGB) 
option.

This option is not available for the Integrated Fiery Color Server.

For information about the PDF/X Output Intent feature, see Color Printing.

This option is only accessible from Command WorkStation Job Properties.

Option Information
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Gray & Black Processing

Output

Option Information

Gray (CMYK) Select these settings to print a CMYK job using black dry ink instead of process black.

This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale 
using black only, when C=M=Y=0 and K=n, where n is not zero. (Graphics refer to vector graphics; 
Images refer to raster images.)

This option is designed to use black efficiently, by using only black dry ink (rather than four-color 
process black).

For more information, see Color Printing.

Gray (RGB) Select these settings to print an RGB job using black dry ink instead of process black.

This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale 
using black only, when R=G=B. (Graphics refer to vector graphics; Images refer to raster images.)

This option is designed to use black efficiently, by using only black dry ink (rather than four-color 
process black).

For more information, see Color Printing.

Black Text and Graphics Select Normal to print black text and graphics as a four-color black using C, M, Y, and K dry ink, and 
to use normal PostScript rendering.

Select Pure Black On to print black text and graphics as a one-color black, using black dry ink only.

Select Rich Black On to print black text and graphics as richer looking black, by layering a small 
amount of Cyan dry ink underneath the black dry ink to make the black even darker.

This option is automatically set to Pure Black On if the Black Overprint option is enabled.

For more information, see Color Printing.

Black Overprint (for pure black) Select Text to overprint black text. 

Select Text/Graphics to overprint black text and graphics. 

For more information, see Color Printing.

Option Information

Default Output Profile Specify the output profile to use for the current print job.

For information about output profiles, see Color Printing.
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Image options

For information about options specified in Setup, see Configuration and Setup.

Option Information

Halftone Simulation Specify a halftone screening method for your print job.

Select Application Defined to use the screening set by the application.

Select Newsprint if you want a look similar to that of a newspaper.

Select User Defined 1-3 to use the screening set by the EX700i.

The User Defined Screen 1-3 settings reflect the setting specified in EX700i Setup.

This option is not available for the Integrated Fiery Color Server.

For more information, see Command WorkStation Help.

Image Smoothing Select On to minimize grainy output when printing low-resolution images.

Brightness Specify the image brightness for the printed document.

Select 85% for a substantially lighter image, 115% for a substantially darker image, or use one 
of the settings in between.

Image Quality Specify the type of image quality for the job.

The Image Quality option affects the fineness of images in the job; there is a trade-off with 
processing speed.

Printer Screen Mode When printing graphics, specify one of the screens that are available on the digital press when printing 
a job. 

Text/Graphics Quality Specify the type of text and graphics quality for the print job. 

The text/graphics quality affects the sharpness and fineness of text and graphics in the job, with a 
trade-off in processing speed.

Select Normal for a good quality and faster processing speed. 

Select Best for the sharpest possible text and graphic edges with slower processing speed.

Text/Graphics Edge Enhancement Specify if you want to sharpen the edges of text or vector graphics. 

Text Sharpness Correction Specify On to correct the sharpness of the text and graphics edges.

Image Enhance: Apply Image 
Enhancement

Specify On to apply photo finishing enhancement to the job.

The supported file formats are .pdf, .ps, .tiff, and .eps.

For more information, see page 134.

Image Enhance: Image 
Enhancement Range

Specify all pages, specific page(s), or sheets of the document to apply photo finishing enhancement.
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Finishing options

Option Information

Use Set Page Device Output Bin 
Tray Mapping

Select On to allow the EX700i to map the Output Bin Tray on a job-level basis. Set Page Device (SPD) 
Media Mapping must be enabled in EX700i Setup to use this option. For information about enabling 
in Setup, see Configuration and Setup. 

This option is only accessible from Command WorkStation Job Properties.

For more information, see Configure Help.

Collate Specify how to output multiple-page/multiple-copy jobs.

For more information, see page 129.

Output Tray Specify the output tray for the job.

Offset Jobs Select On to offset (shift in output tray) the job.

Output Delivery Specify the output delivery for the printed job.

Select Face down - normal order or Face up - reverse order to print your document on the bottom of 
the sheet of paper (the document outputs from the digital press with the text facing down). 

Select Face up - normal order or Face down - reverse order to print your document on the top of the 
sheet of paper.

For more information, see page 134.

Image Shift Adjust an image for duplex printing by shifting the image horizontally, in the direction of paper travel, 
relative to the leading edge.

For more information, see printer driver Help.

Fold Style Specify a fold style for the print job.

For more information, see page 132.

Fold Order Specify whether the pages of your folded job print with the imageable area on the inside or outside of 
the folded sheet.

For more information, see page 132.

Stapler Mode Specify the number of staples and their positions.

For more information, see page 137.

Punch Edge Specify the location of punched holes.

A finisher with the Punch option must be installed to use this option. 

For information about installing finishers and other installable options, see printer driver Help.

For more information about punch settings, see page 135.

Punch If a punch finisher is not installed, this option is set to Off.

For information about installing finishers and other installable options, see printer driver Help.

For more information about punch settings, see page 135.
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Trim: Spine Pressing Use this option to compress the spine edge of your booklet print job. 

NOTE: This option requires a 5-sheet minimum. 

Trim: Engage Fore Trim Select On to trim the edges of your booklet print job. 

NOTE: This option uses a standard calculation based on the number of sheets, page size, media type 
and weight, and spine width of your booklet. You can use the separate Trim Adjustment option to fine 
tune the amount of trimming. 

NOTE: A finisher must be installed to use this option. 

Trim: Finish Size When Engage Fore Trim is set to On, use this option to specify the finished booklet size after 
trimming. 

The finish size increment is 0.1 mm (0.001 inch).

Trim: Trim Value When Engage Fore Trim is set to On, use this option to adjust the amount of trimming. 

The trim value increment is 0.1 mm (0.001 inch).

Option Information
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Variable Data Printing (VDP) options

The EX700i is compatible with the following variable data printing languages: 

• FreeForm and FreeForm 2 

• Portable Document Format/Variable Transactional (PDF/VT)

This format is not available for the Integrated Fiery Color Server.

• Personalized Print Markup Language (PPML)

This format is not available for the Integrated Fiery Color Server.

• Creo Variable Print Specification (VPS)

This format is not available for the Integrated Fiery Color Server.

• Xerox Variable Data Intelligent PostScript Printware (VIPP)

This format is not available for the Integrated Fiery Color Server.

For more information about VDP languages, see Variable Data Printing.

When you create VDP documents, the following settings for the master document and 
variable document must match: 

• Color Mode

• Combine Separations

• Duplex

• Document Size

• Stapler Mode

The following setting for the variable document overrides the corresponding settings in the 
master document:

• Output Tray

Option Information

Create Master To create a FreeForm master from this job, specify a number to assign to the FreeForm master file.

Command WorkStation allows you to select up to 100 FreeForm Masters.

For more information, see Variable Data Printing.

Use Master For variable data print jobs, specify a FreeForm master number to be used for the job.

Command WorkStation allows you to select up to 100 FreeForm Masters.

For more information, see Variable Data Printing.

Preview Master Click Preview Master to generate a low-resolution image of your master page.
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Stamping/Watermark options

Print Master Verify or confirm your Master page.

For more information, see Variable Data Printing.

Printer’s default reflects the setting specified in EX700i Setup.

Remove White PPT Background Select On when using Microsoft Office PowerPoint to create variable data in conjunction 
with FreeForm.

This option removes the white background from PowerPoint files.

Enable Enhanced FreeForm Select On to allow the mapping of select pages from the FreeForm master file in the desired order and 
merge with the variable file when the job is processed.

For more information, see Variable Data Printing.

Pages Per Record Define record-based (rather than job-based) finishing, based on the number entered.

This option is used with the Define Record Length option. 

For more information, see Variable Data Printing.

Define Record length Process a PDF or PostScript file like a variable data print job, and apply record-based finishing. 

This option is used in connection with the Pages Per Record option.

For more information, see Variable Data Printing.

Cache PDF and PS objects Specify On to cache PDF and PS objects, a feature that recognizes objects (text, images, vectors) within 
a PostScript or PDF file and caches the image, reducing the need to reRIP (re-process) image data for 
faster printing.

For more information, see Variable Data Printing.

This option is only accessible from Command WorkStation.

Option Information

Option Information

Watermarks Select standard text for your watermark from the pull-down menu. 

To create your own watermark, click New.

To modify a standard watermark, select it from the pull-down menu and click Edit.

To remove a watermark from the list, select it from the pull-down menu and click Delete.

For more information about using watermarks, see printer driver Help.

Print Watermarks: First Page 
Only 

Print watermarks on only the first page. For more information about using watermarks, see printer 
driver Help.
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Overriding print option settings
Print option settings that were specified in the printer driver can be overridden in Command 
WorkStation Job Properties.

TO OVERRIDE JOB PROPERTIES

1 In Command WorkStation, right-click a held job in the Job Center view.

2 Choose Properties from the pop-up menu.

3 Specify the print option settings, and then click Print.

You can override most print options in the printer driver and Command WorkStation Job 
Properties. Exceptions are listed in the following table: 

Printer driver tab Option Driver 
Win

Driver 
Mac

CWS

JOB INFO Print Range X

Print Queue Action X X

Secure Print X X

User Authentication: Username X X

User Authentication: Password X X

User Authentication: Use Windows Login X

User Authentication: I’m a Guest X

MEDIA Document Size X

Use Set Page Device Media Mapping X

LAYOUT: Normal Mirror X

Orientation X

COLOR Optimize RGB Transparency X

COLOR: EXPERT SETTINGS PDF/X Output Intent X

FINISHING Use Set Page Device Output Bin Tray Mapping X

VARIABLE DATA PRINTING Preview Master X X

Cache PDF and PS objects X

STAMPING/WATERMARK Watermarks X X

Print Watermarks: First Page Only X X

ALL TABS Adobe PDF Print Engine Preferred X
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Additional information
The following sections provide additional information about print options. For more 
information about options, see the tables that begin on page 100.

Auto Trapping

Trapping is a technique to print some objects slightly larger or smaller than specified in an 
application, in order to prevent white edges around the objects. These white edges, or “halos,” 
can be caused by factors such as misregistration, the physical properties of the dry inks, and 
the stiffness of the media. The Auto Trapping feature provides you with advanced trapping 
settings and gives you full control over their values. For more information, see Color Printing.

Booklet Maker

Booklet Maker is the imposition tool that allows you to quickly print documents in booklet 
format, without the need for more involved page imposition programs. Booklet Maker 
provides advanced settings, while streamlining the booklet-making process by displaying only 
the options and controls relevant to your selections. Booklet Maker is capable of imposing 
jobs from nearly any application.

Access Booklet Maker in the printer driver when you print a job, or in Command 
WorkStation Job Properties, where you can modify a job’s properties.

NOTE: Mixed Media jobs and VDP jobs are not supported when using Booklet Maker.
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The following booklet layouts are available:

Saddle binding: In Saddle binding, signatures are folded together as a group, and then stapled 
or stitched along the center fold, which forms the spine of the booklet. 

Nested Saddle binding: The Nested Saddle binding method combines saddle and perfect 
binding methods by stacking two or more saddles (also called “groups” or “subsets”) together 
along the common fold, then gluing them together at the fold to form the spine.

Perfect binding: In Perfect binding, separate folded pages are printed and stacked in 
booklet order. Finished pages are stitched adjacent to one another for trimming or gluing.

For Booklet Maker options and available settings, see the table that begins on page 108.

For information about using Booklet Maker options, see Booklet Maker Help.

Saddle
(left) binding

Saddle
(right) binding

1

Saddle
(top) booklet

1 1

Nested Saddle
(left) binding

Nested Saddle
(right) binding

Nested Saddle
(top) binding

Front Back Perfect booklet
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Booklet Maker in the printer driver

You can choose to work with Booklet Maker in the printer driver in two ways:

• Using the Booklet Maker wizard

Recommended for first-time or novice users.

• Specifying settings in the main Booklet Maker dialog box

Recommended for experienced or advanced users.

For Booklet Maker options and available settings in the printer driver, see the table that 
begins on page 108.

To use Booklet Maker to print a booklet from the printer driver, use one of the following 
procedures.

TO ACCESS BOOKLET MAKER FROM THE WINDOWS PRINTER DRIVER

1 In your application, choose File > Print.

2 Select the EX700i as your printer, and then click Properties.

3 In the printer driver, click the Layout icon, and select the Booklet option.

For information about using Booklet Maker options, see Booklet Maker Help.

TO ACCESS BOOKLET MAKER FROM THE MAC OS X PRINTER DRIVER

1 In your application, choose File > Print.

2 Select the EX700i as your printer, and then choose Fiery Features from the drop-down list.

3 Click Full Properties in the Quick Access pane.

4 In the printer driver, click the Layout icon, and select the Booklet option.

For information about using Booklet Maker options, see Booklet Maker Help.

Booklet Maker in Job Properties

You can choose to work with Booklet Maker in Job Properties in the following ways:

• Using the Booklet Maker wizard

Recommended for first-time or novice users.

• Specifying settings in the main Booklet Maker dialog box

Recommended for experienced or advanced users.
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To access Booklet Maker from Command WorkStation Job Properties, use the following 
procedure.

TO ACCESS BOOKLET MAKER FROM COMMAND WORKSTATION

1 Double-click your print job in the Held or Printed list, or right-click the job and select 
Properties.

2 Select the Layout icon in the Job Properties window.

3 Select the Booklet option.

4 Choose the Booklet Maker settings or click Launch Wizard to choose the settings graphically.

For information about using Booklet Maker options, see Command WorkStation Help.

About Booklet Maker imposition

Imposition is the process of printing multiple pages on single sheets of paper. When the 
imposed sheets are folded together as signatures, the pages follow in sequential or reading 
order. Booklet Maker is designed for 2-up imposition, which imposes four individual pages 
from your document on a single sheet that is printed duplex. 

The order in which pages are imposed is determined by the binding method you select. 

Booklet Maker and Impose

Booklet Maker settings are supported by Impose, if enabled. You can open a job with Booklet 
Maker settings in Impose to preview the imposition layout or further modify the imposition 
layout, if necessary.

Impose translates and maps all Booklet Maker settings to Impose commands.

NOTE: When a job with Booklet Maker settings has been edited in the Impose window, the 
job can no longer be edited in Booklet Maker. Impose offers more settings that cannot be 
mapped to Booklet Maker settings.

For more information about Impose, see Utilities.
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Main Booklet Maker window

In the main Booklet Maker window, Booklet Maker dynamically displays all of the controls 
applicable to creating a booklet. 

TO CREATE A BOOKLET

1 Select a Booklet Type: Saddle, Nested Saddle, or Perfect.

2 Select a binding edge: Left, Top, or Right.

3 Specify a Paper size.

4 Select Shrink to Fit, if required.

5 Specify Page Alignment.

6 Specify Creep compensation, if required.

Creep compensation is available for Saddle and Nested Saddle booklets.

7 Specify cover settings, if you selected a Saddle booklet in step 1. 

NOTE: Cover settings are only available for Saddle booklets. For more information, see 
“Adding a cover” on page 127.

8 Click OK to save your settings, Cancel to cancel the job, or Print to print your job.

Booklet Maker wizard

In the Booklet Maker wizard, accessed by clicking Launch Wizard, the windows display the 
steps in the booklet-making process.

TO NAVIGATE THE WIZARD

• To advance from one window to the next, click Next.

• To return to previous windows, click Back.

• To cancel settings and exit Booklet Maker, click Cancel.

TO CREATE A BOOKLET USING THE WIZARD

1 Click Launch Wizard.

2 Specify the Booklet Type (binding method) and Binding edge.

3 If Saddle was selected for Booklet Type, specify cover and content settings, and then click 
Next.

4 Specify paper size for the body, and then click Next.

If Saddle was selected for Booklet Type, specify the paper setting for the cover, and then click 
Next. 

5 If Nested Saddle was selected for Booklet Type, specify number of sheets in a subset.
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6 Specify body alignment and gutters, and then click Next.

If Saddle or Nested Saddle was selected for Booklet Type, specify Creep compensation.

7 View the settings summary. 

8 Click Finish to save your booklet, Back to change any settings, or Cancel to cancel the job.

Adding a cover

Covers are an option for Saddle booklets only.

TO INSERT A PRE-PRINTED COVER

1 In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.

2 Specify the required settings for Paper Size and Page Alignment for the body of the booklet.

3 Specify Pre-Printed from the Cover Content input menu.

4 Click Define Cover and specify media type and media weight, and the source tray from the 
Cover Source menu.

5 Click OK.

TO SPECIFY AN INLINE COVER

1 In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.

2 Specify the required settings for Paper Size and Page Alignment for the body of the booklet.

3 Choose Front & Back Separately from the Cover Content input menu.

4 Specify the Front Cover and Back Cover settings.

5 Click Define Cover and specify media type and media weight, and the source tray from the 
Cover Source menu.

6 Click OK.

NOTE: When you print an inline cover with top-edge binding, the outside back cover 
automatically rotates 180 degrees to match the orientation of the front cover.
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Cover options

For Saddle only, Booklet Maker includes two cover options, either pre-printed or inline, for 
which you can specify media. You can specify additional options for an inline cover. 

• Content Input: Select from Front and Back Separately or Pre-Printed.

• Front and Back Separately: Select this option to specify an inline cover that prints the 
cover pages and body pages as a single job. Separate pages from your document are 
imposed on a single sheet that forms the cover of your booklet. 

You can specify an inline cover when your original document includes the cover pages 
and/or cover artwork for your booklet. The cover content may be the first and last pages of 
your document, or the first two and last two pages of your document, or any combination. 

If you select this option, you can specify the Front Cover and Back Cover options below.

• Pre-Printed: Select this option to insert a pre-printed cover that will be merged with the 
body pages of your booklet, which print separately. 

If you select this option, the Front Cover and Back Cover options below are disabled.

• Front Cover and Back Cover: These options allow you to quickly decide whether your front 
and back covers print duplex, single-sided, or both sides blank, without needing to add 
blank pages in your original document.

With top-edge binding that includes a cover, the outside of the back cover automatically 
rotates 180 degrees to match the orientation of the front cover.

• Define Cover: This option allows you to select a media and size for your cover pages, which 
may be trimmed. You can also specify the Cover Source tray for the cover media.

This option is available for both pre-printed and inline covers.

Printing Booklet Maker jobs

Booklet Maker does not support jobs sent to the Direct queue. Booklet Maker print jobs 
must be sent to the Print queue or Hold queue. 

TO CHANGE THE UNIT OF MEASUREMENT

1 In Command WorkStation, go to Edit > Preferences.

2 Click the Size tab.

3 Select the unit of measurement (millimeters, points, or inches).

4 Click OK.

Changes are not effective until the next time Command WorkStation is started.
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Collate

Use this option to specify sorting options.

On: Copies of a complete job are sorted as 1-N, 1-N.

Off: Copies of a complete job are sorted as 1,1, 2,2, 3,3.

NOTE: The Collation of Mixed Media and Variable Data Printing (VDP) jobs is handled 
differently. For mixed media jobs, copies of a complete job are sorted according to finishing 
set. For variable data printing jobs, copies of a complete job are sorted per record.

For more information about VDP, see Variable Data Printing. For information about Mixed 
Media, see Utilities.

Defining and printing custom page sizes

With custom page sizes, you define the dimensions of a printed page. After you define a 
custom page size, you can use it from within an application without redefining it each time 
you print. When you create custom page sizes, specify Width dimensions to correspond with 
the shorter side of your job and specify Height dimensions to correspond with the longer side 
of your job. Set custom page sizes in this way, regardless of the orientation settings in the 
application.

NOTE: Custom page sizes are not supported with Imposition jobs.

For information about defining and printing custom pages sizes, see printer driver Help.

Height

Width

Width

Height

Portrait Landscape
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Document size and Paper size

Document size is the page size defined in your application’s Print setup (or Page setup) dialog 
box. Paper size is the size of the actual sheet of paper on which your job is printed. It may be 
useful to think of Document size as digital input (the page size defined in your original 
document) and Paper size as the physical output (the actual size of the paper in the digital 
press tray).

In cases when you print one document page per sheet of paper, Document size is usually the 
same as the Paper size. However, Document size may differ from Paper size when you print 
booklets or impose multiple document pages on a single sheet. 

The following illustrations show examples of possible relationships between Document size 
and Paper size. Note that the orientation of all pages shown is Landscape.

Document size may also differ from Paper size when using the Scale or Scale to Fit options. 
The Scale option reduces or enlarges the document page at a specified percent. The Scale to 
Fit option automatically reduces or enlarges the document image to fit the selected Paper size. 

For information about Scale and Scale to Fit, see page 136.

For information about Document size and Paper size in booklet printing, see Booklet Maker 
Help.

Document size (input) Paper size (output)

Document size is the 
same as Paper size.
Scaling is 100%.

Letter Letter

Tabloid Document size scaled 
to fit on Letter Paper size. 
Scaling is 50%.

Tabloid 11x17 Letter

A4 Document size scaled to 
fit on A3 Paper size.
Scaling is 141%.

A4 A3

A A
A A

A A
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Duplex printing

TO PRINT DUPLEX (DOUBLE-SIDED) PAGES

1 In your application, choose File > Print, select the EX700i as your printer, and do one of the 
following.

Mac OS X: Choose Fiery Features from the drop-down list, click Full Properties in the Quick 
Access pane, and then select Normal on the Layout tab.

Windows: Click Properties, and then click the Layout icon.

2 Choose one of the Duplex settings:

Top-Top: Prints the top of the image on Side 1 on the same edge of the page as the top of the 
image on Side 2.

Top-Bottom: Prints the top of the image on Side 1 on the opposite edge of the page from the 
top of the image on Side 2.

The following table shows how the Duplex settings correspond to printed output. 

3 Print the job.

Top-Top Top-Bottom

Portrait

Landscape

1 2 1
2

1 2 1

2
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Folding options
The following types of fold are supported:

NOTE: When you select a folding option, Output Delivery is automatically set to Face down-
normal order. It is not possible to print folded jobs face up or in reverse order. The Fold 
Order option allows you to specify whether text/images print on the inside or outside of the 
folded sheet. Special finishers must be installed to use the Folding options. 

For information about finishers and other installable options, see printer driver Help.

Half-fold Booklet fold

Z-fold Half Z-fold

Tri-fold
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Gang-up printing

The EX700i includes two speed-printing options: 

Step & repeat: Select this option to speed print a job so that the first page of your document 
is printed twice on the first sheet. The next sheet duplicates the data on the second page, the 
next sheet duplicates the data on the third page, and so on. When the printed sheets are cut in 
half, the result is two complete sets of the same document.  

Cut & stack: Select this option to speed print a job so that when the sheets are stacked and cut 
from the central position, the job is numbered in order and separated as two stacks. The print 
order is such that when the sheets are cut in half, you can combine them to form a single 
complete set of the document, in faster printing time.

For available options and settings, see the table on page 107.

TO ACCESS GANG-UP PRINT FROM THE WINDOWS PRINTER DRIVER

1 In your application, choose File > Print.

2 Select the EX700i as your printer and click Properties.

3 In the printer driver, click the Layout icon and select the Gangup option.

TO ACCESS GANG-UP PRINT FROM THE MAC OS X PRINTER DRIVER

1 In your application, choose File > Print.

2 Select the EX700i as your printer and choose Fiery Features from the drop-down list.

3 Click Full Properties in the Quick Access pane.

4 In the printer driver, click the Layout icon and select the Gangup option.

Front only Front Back

Single-sided Duplex (double-sided)

Front only Front Back

Single-sided Duplex (double-sided)
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Image Enhance

The Image Enhance feature lets you apply photo finishing enhancement to color images on 
specified pages or sheets of a job. This feature affects only photographic images, not graphics 
such as logos or charts. To enable this feature, select the Apply Image Enhancement option 
for a job and specify the pages or sheets to be affected. This option is located in the Image tab 
of the printer drivers and Command WorkStation Job Properties. You can customize Image 
Enhance settings from Command WorkStation. For information about customizing Image 
Enhance settings, see Command WorkStation Help.

Output Delivery

Output Delivery allows you to specify how the stack of copies is delivered in the output tray.

Select Face up for sheets delivered into the output tray with copies facing up, with Normal 
order for the first sheet on the top of the stack, or Reverse order for the first sheet on the 
bottom of the stack.

Select Face down for sheets delivered into the output tray with copies facing down, with 
Normal order for the first sheet on the bottom of the stack, or Reverse order for the first sheet 
on the top of the stack.

NOTE: When using a finisher that reverses the order of the stack, you can specify Reverse order 
so that when the stack is fed through the finisher, the pages are delivered in the correct order. 

1 Face up - Normal order
2 Face up - Reverse order

1 2

1 Face down - Normal order
2 Face down - Reverse order

1 2
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Punch Edge Position and Hole Punching

The following table illustrates the number of holes and punch positions.

NOTE: Punch positions vary according to paper size, paper type, number of pages, and feed 
direction.

For information about finishers and other installable options, see printer driver Help.

Punch setting Portrait Landscape

Left Right Top Left Right Top

Two Holes

Three Holes

Four Holes

Advanced-Letter /
Advanced-A4



PRINT OPTIONS 136

Scale

The operator can specify a scaling override in Command WorkStation, but the override is 
applied to any scaling value already set in the active job. For example, if a user sends a job 
with a scaling value of 50% and the operator specifies a Scale override of 300%, the job is 
printed at 150% of the original document size, that is, 50% of 300%.

Scale to Fit

The Scale to Fit option allows you to scale a job to a Paper size different from the Document 
size. When you set this option to On, the image is increased or reduced in size to fit the 
imageable area of the paper size you select from the Paper Size menu. When you set this 
option to Off, the original document size is printed without any scaling, even if you select a 
larger paper size.

Document size
Letter

Paper size
11 x 17

Scale to Fit set to On

Scale to Fit set to Off
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Stapler Mode

Stapling is supported on the digital press with the Advanced Finisher, Light Production 
Finisher, Booklet Maker Finisher or the Professional Finisher attached. 

NOTE: Page orientation, such as landscape and portrait, will affect the stapling output.

Off: Disables the stapler.

Left Top Single: The job is stapled with one staple in the left top corner of the page.

Right Top Single: The job is stapled with one staple in the right top corner of the page.

Left Center: The job is stapled with one staple in the center of the left page edge.

Right Center: The job is stapled with one staple in the center of the right page edge.

Top Center: The job is stapled with one staple in the center of the top page edge.

Left Double: The job is stapled with two staples along the left page edge.

Right Double: The job is stapled with two staples along the right page edge.

Top Double: The job is stapled with two staples along the top page edge.

Left Quad: The job is stapled with four staples along the left page edge.

Right Quad: The job is stapled with four staples along the right page edge.

Top Quad: The job is stapled with four staples along the top page edge.

Center: The job is printed like a booklet with staples in the center of the page.

For information about installing optional finishers, see printer driver Help.
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User Authentication

If Users and Groups user authentication has been enabled in the EX700i Setup, you must 
enter a valid user name and password to send a print job to the EX700i. In Command 
WorkStation, the management of jobs is determined by how you have logged on to the 
EX700i.

For Mac OS X: Select the Job Info icon and type logon information in the User Name and 
Password fields. 

Use Windows Login: Choose this option if you are already logged on to a Windows computer. 
Otherwise, type your Windows network logon information in the Username and Password 
fields.

Validate: Click to validate user authorization and to confirm printing privileges. To validate, 
Two-Way Communication must be activated. For information on establishing Two-Way 
Communication, see printer driver Help.

I’m a guest: Choose this option to activate guest printing privileges. By default, guest printing 
is permitted.

For information about enabling Users and Groups user authentication in the Configure 
WebTool, see Configuration and Setup.
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Numerics
2-Color Print Mapping option 112

A
Adobe PDF Print Engine option 94
APPE 94
AppleTalk connection, Mac OS X

20, 24, 25
Apply Image Enhancement option 116
Auto Trapping option 111, 122
automatic rotation 127

B
Basic icon, customizing 33
binding method 108
binding options 126
Black Detection option 111
Black Overprint option 115
Black Text and Graphics option 115
Booklet layout mode 108
Booklet Maker

Back Cover option 110
binding method 108
Centering Adjustment option 109
Cover Content option 109
Creep compensation 109
Define Cover option 110
Front Cover option 109
Gutter option 109
Increase gutter by option 109
Nested Saddle booklets 123
Page Alignment 109
Paper size 107
Paper size for 2-up 108
Shrink to fit option 108

Booklet Maker settings 125
Booklet Maker wizard 124, 126
Booklet option 122
Booklet type

binding method 108
Brightness option 116

C
Cache PDF and PS objects 120, 121
CMYK mode 111
CMYK/Grayscale Processing Method 

option 113
CMYK/Grayscale Source option 113
Collate option 117, 129
Color mode 111
Color Setup, job overrides 99
Combine Separations option 111
Composite Overprint option 111
Control Bar 102
Copies option 101
cover

inline 127
pre-printed 127
selecting media for 128

Cover Content Input option 109
cover settings 126, 127
Create Master option 119
Creep compensation 109

D
Default Browser connection 15, 18, 22
Default Output Profile option 115
default print options 58, 83
Define Record Length 120
Destination option 101
Direct Mobile Printing 97
Docs tab in WebTools 28, 54, 79
Document Size option 104, 121
Downloads tab in WebTools 12, 37, 63
Duplex (double-sided) 

option 106, 107, 125, 128, 131
duplex printing see Duplex (double-sided) option

E
E-mail Service

about 87
Manage print jobs 89

Enable Enhanced FreeForm option 120
Engage Fore Trim option 118

INDEX



INDEX 140

F
Fiery Features 31, 33
Fiery Software Uninstaller Utility

deleting 13
installing and using 13
on User Software DVD 9

File Name option 101
File port, saving files to 59, 84
Finish Size option 118
first-time use 124
Fold Order option 117
Fold Style option 117
Folding option 132
FreeForm

Preview Master option 121
Print Master option 120

FTP Printing 92

G
Gang-up print

Cut & stack 133
Gang-up type 107
Gutter option 107
Increase gutter by option 107
Shrink to fit option 107
Step & repeat 133

Gang-up type 107
Gangup layout mode 107
Gray (CMYK) option 115
Gray (RGB) option 115
Grayscale mode 111
gutters 107, 109

H
Halftone Simulation 116
Hot Folders

job overrides 99

I
I’m a Guest option 101, 121, 138
Image Enhance 134

Apply Image Enhancement option 116
Image Enhancement Range option 116

Image Quality option 116
Image Shift option 117
Image Smoothing option 116
Impose layout mode 110
imposition 125

installable options
configuring 53, 78
configuring for Windows Vista 53, 78

installing
Job Monitor 86
printer driver from User Software 

DVD 39, 64
printer drivers from server 38
printer drivers over the network 12
printer drivers using Point and Print 35, 61
virtual printers using Point and Print

43, 68
Instructions field 102
IP Printer connection 16, 19, 23
IPP connection 51, 76

J
Job Monitor

configuring connection 86
installing 86
on User Software DVD 9
using 86

job overrides, print settings 99

L
Language folders 11
Layout option see Pages per sheet
Line Printer Daemon - LPD 16, 19, 23
LPD/LPR connection, Mac OS X 26
LPR connection, Windows 47, 72

M
Mac OS X

AppleTalk connection 20, 24, 25
Default Browser connection 15, 18, 22
deleting printer driver files 13
Fiery Software Uninstaller utility 13
IP Printer connection 16, 19, 23
Line Printer Daemon - LPD 16, 19, 23
LPD/LPR connection 26
printer driver setup 14
printing from applications 28
selecting printers 29

Manage print jobs 
with e-mail commands 89

managing print jobs 89
Manual Duplex option 106
measurement unit, specifying 128
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Media Color option 103
Media Type option 103
Media Weight option 103
Mirror option 106, 121
Mixed Media option 105

N
Nested Saddle booklets 123
Notes option 102

O
Offset Jobs option 117
Optimize RGB Transparency option 112, 121
Orientation option 106, 121
OSX Installer 11
Output Delivery option 117, 134
Output Tray 117
overrides, of job settings 99

P
Page Order option 106
Pages Per Record 120
Pages per sheet option 106
Paper Catalog option 103
Paper Simulation option 113
Paper Size option 103, 130
Paper Source option 103
Password 101, 121
Perfect booklet setting 123
Point and Print 35, 61
Postflight 102
PostScript fonts 9
PostScript Printer Description file, see PPD
PostScript printer driver

deleting 45, 70
download using WebTools 37, 63
installing from User Software DVD 39, 64
installing using Point and Print 35, 61

PostScript printer drivers, explained 98
PPD (PostScript Printer Description file)

options 99
overview 9
Windows 40, 65

Preview Master option 119, 121
Print Border option 106
Print dialog box 30
Print Master option 120

print options 32, 56, 81, 98
Print Queue Action option 102, 121
Print Range option 101
printer default settings, where to set 99
Printer Delete Utility 9, 13, 45, 70
printer drivers

downloading with WebTools 12
installing 64-bit printer driver 42, 67
setting up 14

Printer Screen Mode option 116
Printer Setup Utility 11
Printer’s default 30, 55, 80
printing

from a mobile device 97
from an application 55, 80
from Mac OS X applications 28
to File port 59, 84
using an E-mail client 87

printing connections, supported types 46, 71
Prntdrve.exe file 37, 63
Progressives 102
Punch Edge option 117, 135
Punch option 117, 135
Pure Black see Black Text and Graphics

Q
Quick Access window, customizing

33, 59, 84

R
reading layout 125
Remove White PPT Background option 120
RGB Source option 113
RGB/Lab Rendering Intent option 114
Rich Black see Black Text and Graphics
RIPping 98
Rotate 180 (check box) option 106
rotation, automatic 127

S
Scale option 106, 136
Scale to Fit option 106, 136
Schedule Printing option 101
Secure Print option 102, 121
Secured Print option 93
selecting printers

Mac OS X 29
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Separate RGB/Lab to CYMK Source 
option 114

sheet 125
Shrink to fit 107, 108
single-sided printing 128
Slip Sheet Offset option 104
Slip Sheet option 104
SMB printing

completing connection 46, 71
setup 35, 61

speed printing see Gang-up print
Spine Pressing option 118
Spot Color Matching option 114
Standard Booklet setting 123
Stapler Mode option 117
Step & repeat 133
subset 126
Substitute Colors option 111

T
TCP/IP connection 47, 72
Text Sharpness Correction option 116
Text/Graphics Edge Enhancement

option 116
Text/Graphics Quality option 116
top binding with a cover 128
Transparency Interleave Paper Source 105
Transparency Interleaving option 104
Tray Alignment option 103
Trim Value option 118
Two-Way Communication 30, 44, 55, 59,

69, 80, 84

U
USB device 90

automatic printing of files 90
Use embedded profile when present 

option 113
Use Master option 119
Use PDF/X Output Intent 114
Use Set Page Device Media Mapping 

option 104, 121
Use Set Page Device Output Bin Tray

Mapping option 117, 121

User Authentication
for Mac OS 138
I’m a Guest option 138
Password option 101, 121, 138
Use Windows Login option

101, 121, 138
Username option 101, 121, 138
Users and Groups user authentication 138

User Software DVD
installing printer driver files 11

V
Variable Data Printing (VDP)

Cache PDF and PS objects 120, 121
Create Master option 119
Define Record Length 120
Pages Per Record 120
Preview Master option 119, 120, 121
Use Master option 119

virtual printers
installing using Point and Print 43, 68
setting up 43, 68

W
Watermarks option 120

First Page Only setting 120
WebTools

Docs tab 28, 54, 79
Downloads tab 12, 37, 63

Windows
IPP connection 51, 76
LPR or Port 9100 connection 47, 72
printer driver, installing from 

User Software DVD 39, 64
TCP/IP connection 47, 72

Windows Server 2003
installing 64-bit printer driver 42, 67
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